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Part 1 

THE GEM COLLECTION 
 



CONVENTIONS USED IN THIS 
MANUAL 

*CONFIGURE 

<number> 

Open 

4g 

9] 
User Guide 

Text to be typed in literally, or text displayed on the screen. 

An item of data of the type indicated must be supplied, or is 

displayed on the screen. For example, a line described as Page 
<number> would appear with a number in place of <number>. 

Option in a menu line or dialogue which can be selected with the 

mouse. 

Press the key named. 

Press a numeric keypad key. This MUST be used where shown; 
where numbers are shown otherwise, either set of numeric keys 
may be used. 

Press the red function key indicated. 

The title of a manual.
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1 INTRODUCTION 
  

1.1 What is GEM? 

The GEM software package consists of three applications. These are: 

GEM Desktop 

GEM Write 
GEM Paint. 

GEM Desktop is a filing and administrative system. It allows you to control and 

order the documents and pictures you create using GEM Write and GEM 

Paint. 

GEM Write is a versatile word-processing system. Using GEM Write you can 

produce documents of any length from the briefest letter to a full length book. 

GEM Paint is a graphics program which enables you to produce exciting and 

original pictures using a variety of painting techniques and automatically 
generated patterns. 

The three parts of the GEM package are closely linked. The most unusual 

feature of the package is that you can incorporate pictures created using GEM 

Paint into GEM Write documents. Documents and pictures can be arranged in 

a filing system using GEM Desktop, and printed. 

Although the GEM applications interact closely, it is not necessary to 
understand how to use every part before you start. After mastering the basic 

principles, you could begin with GEM Write or GEM Paint and produce a 
document or painting before learning how to operate GEM Desktop.



1.2 How to Use this Manual 

This manual is divided into the following sections: 

1 Introduction 

This introduces the general concepts of GEM and some of the terms and 

techniques you will encounter. The first time you use GEM, go from the 

introduction to the Set-up Guide in the Appendix. 

2 Starting to Use GEM 

This introduces procedures which are common to all the GEM applications, and 
the Desktop features necessary to beginning the Paint and Write programs. 
After reading this section, you can read any of Sections 3, 4 or 5 next. It may be 
best to go to Write or Paint, returning to the other Desktop commands later. 

3 GEM Paint 

This describes the drawing and other techniques available within Paint. You 

should experiment freely with Paint, as this is the easiest way in which to learn 
how to use it. 

4GEM Write 

This describes all the operations available within GEM Write. It refers you to a 
tutorial supplied on the dises which demonstrates the use of all the facilities. 

5 GEM Desktop 

This section describes the techniques and procedures which are specific to 
Desktop. It may be left until after you have become acquainted with Write 

and/or Paint. 

6 Output 

The Output Guide describes the output options available from GEM Desktop, 
Gem Write and Gem Paint. As the procedures are the same irrespective of 

which application they are accessed from, they are grouped together in a 
separate section. You should create one or more documents with Write or Paint 

before using the output options.



7 Appendix: Set-up Guide 

This covers the procedures involved in setting up the hardware and software 

before you can use the GEM package. Most of this information will be required 

once only. 

8 Glossary 

9 Index 

1.3 General Concepts 

The GEM package is based on the use of the mouse and the display of symbols 

on the screen. Moving the mouse causes a pointer to move around on the 

screen. You will quickly become accustomed to how far you need to move the 

mouse to achieve the corresponding movement of the pointer which you 

require. 

The symbols displayed on the screen represent facilities or attachments which 

are available. They are known as ICONS. For example, GEM Desktop displays 

a floppy disc icon, a simple line drawing of a floppy disc. All the icons used in 

GEM are easily recognisable. 

As well as the icons, GEM has a series of MENUS, or lists of commands. These 
give access to a wide variety of operations within each GEM application. 

The pointer is moved around the screen to indicate and SELECT items. You 
can select any of the icons, or any of the highlighted commands in the menus. 
Moving the pointer to indicate menu items or icons, and using simple 
CLICKING techniques (described in 2.5) are the basic operations involved in 
using GEM. Combining these operations in a meaningful sequence instructs 
the computer to carry out a command. If you use them in a sequence which does 

not make sense to the computer, you can do no damage. In such a case, either 
nothing at all will happen, or the system will issue a message informing you 
that what you have requested cannot be done. 

Moving the pointer to indicate menu items and icons is a technique which is 
very easy to use. It does not require you to learn and remember a series of 

keystrokes or to be a proficient typist; the facilities available are always readily 

visible on the screen. 

Now turn to the Set-up guide in the Appendix.



2 STARTING TO USE GEM 
  

2.1 Introduction 

This section introduces the procedures and techniques common to all the GEM 

applications, using the Desktop to demonstrate these and provide examples. 

After reading this section, you will be familiar with the general techniques and 

can go on to use Paint, Write or Desktop. It may be better to use Write or Paint 
first, turning to Desktop after creating some documents or paintings to learn 

how to copy and move them. The advantage of using Paint or Write first is that 

if you are moving ‘real’ documents rather than empty ones, you can open them 

to check that the operation has been successful. 

Many of the operations and concepts in this section are introduced with an 
example; follow the instructions to test the procedures or see an example. 

WARNING: 

Always work on copies of the GEM discs. If you have not made copies, or have 

lost them, turn to the Set-up Guide in the Appendix for instructions (7.5). DO 

NOT USE THE MASTER COPIES to run GEM. 

2.2 How to Start GEM 

Ifthe microcomputer has not been prepared for GEM, read the Set-up Guide. If 
you have used GEM before, or have completed the procedures described in the 
Set-up Guide, follow whichever series of instructions below is appropriate. For 
a system with floppy discs, follow the first series (2.2.1); for a system with a 
hard disc, follow the second series (2.2.2). 

2.2.1 Floppy Disc System 

Turn on the machine and monitor, and ensure that the disc drive and mouse 
are connected. 

If the disc drive operates immediately and the word TUBE appears in the top line 

of the message on the screen, insert the Boot disc into the first drive (A: or :0) 

and close the drive door.



If the disc drive does not operate immediately and the word TUBE is not present, 

type 

*CONFIGURE TUBE 

and press the [Retuan] key, then press the [ctat] and [Break] keys 
simultaneously. When the drive begins to operate, insert the Boot disc and 
close the drive door. 

A message similar to 

Boot strap leader 

Loading DOS Plus.. 

reports that DOS is being loaded. When the prompt 

A> 

appears, remove the Boot disc and insert the Program disc in the first drive. 

Either press the red function key [fo] or type 

GEM [RETURN] 

(Close the door when the drive begins to operate.) This loads and runs the GEM 
software. 

2.2.2 Hard Disc System 

Turn on the machine, monitor and hard disc drive and ensure that the mouse is 
connected. 

After a short time, the message 

Boot strap leader... 

may appear. If it does not, type 

* CONFIGURE TUBE 

and press the [Return] key, then press the [cra] and keys 
simultaneously. The Boot strap message will appear when the command has 
been successfully completed. 

Press the [return] key to load DOS plus, the operating system. When the 

operating system has been loaded, the prompt 

o> 

will appear. Either press the red function key 10] or type 

  

to load and run the GEM software.



2.3 The Desktop Screen 

The image which appears on the screen when you first enter GEM is called the 
GEM DESKTOP. All administrative procedures — copying and moving 

documents, etc. — are carried out from the Desktop. The picture below 

illustrates the image which should appear when you first start GEM. 

  

  

2.4 Using the Mouse 

The principle means of communicating with GEM is by moving the mouse and 

CLICKING on items on the screen. 

The mouse must be plugged into the User Port socket on the base of the 
microcomputer. Consult the Set-up Guide, 7.2, if the mouse is not connected. 
Place the mouse on a flat surface with the flex away from you and move it 
around. The rubber ball (visible from underneath the mouse) enables it to move 
freely. Moving the mouse causes a corresponding movement of an arrow — the 
POINTER — over the screen. If the pointer does not move, check that the mouse 
is properly connected. 

  

‘The lefthand button on the front of the mouse is used for clicking, the means of 
selecting items. The clicking techniques are considered next.



2.5 Clicking Techniques 

‘The concepts of icons, menus and using the pointer on the screen were briefly 

introduced in 1.3. In order to use the icons and menus, it is necessary to be 
familiar with the four different clicking techniques. These are referred to 

throughout this manual as 

click 
double-click 
shift-click and 
drag. 

They are executed as follows — do not try them immediately. 

To CLICK on an item, position the pointer over it and press the left-hand 

button on the mouse once. 

To DOUBLE-CLICK on an item, position the pointer over it and press the 

left-hand button on the mouse twice in rapid succession. 

To SHIFT-CLICK on an item, position the pointer over it and hold down the 

SHIFT key on the keyboard, or the righthand button on the mouse, while you 
click on the item using the lefthand button on the mouse. 

To DRAG an icon, position the pointer over it and press and hold down the 
lefthand button on the mouse. Then move the mouse, keeping the button 

pressed down, until the outline of the icon moves to the position you want it to 

be in, then release the mouse button. 

2.6 Folders and Documents 

Folders and documents are part of the filing system provided by GEM Desktop. 

‘They mimic an ordinary office filing system. 

GEM stores the text and paintings you create as DOCUMENTS. Each created 
item is a separate document, and has a different name. The name includes a 
suffix, .DOC or .IMG, indicating whether it is a text DOCument or a graphic 
TMaGe created with Paint. GEM also creates additional documents with 
different suffixes for the use of the program. These will be considered later, 
when they are relevant. They appear on the Desktop, but cannot be accessed 
and used like Paint and Write documents.



Documents are stored in FOLDERS. These are analogous to conventional 
folders; a folder is used to store documents, and does not itself have any text or 

graphics belonging to it — a folder without any documents holds no information. 
Folders may be stored one inside another to form a filing system. This allows 
documents to be kept in an order which reflects their contents, subject 
material, or purpose. For example, you might wish to store all memoranda 
together, and all letters together. You could subdivide the letters into personal 

and business correspondence. A suitable structure of documents would be: 

Top-level folder J 

containing folders | MEMOS LETTERS 

containing folders PERSONAL and BUSINESS 

containing MEMO1.DOC PLETI.DOC BLET1.DOC 
documents MEMO2.DOC PLET2.DOC. 

MEMO3.DOC 

The full name of a document includes the names of the folders in which it is 
stored, and also a letter indicating the dise drive in which the disc holding the 

folder is located. This is the DIRECTORY PATH, and is considered in detail in 
Section 5 (see 5.2). 

A list of the contents of a folder is called a DIRECTORY. A directory may be 

displayed on the Desktop, or listed in an ITEM SELECTOR (described in 2.12) 

when you need to choose a document.



2.7 Windows 

The part of the screen which is occupied by the picture — the Desktop, 

word-processing or painting area — is called the WINDOW. It is possible to alter 
the size of the window, and sometimes to view more than one window at a time, 

to alter the position of the window or to superimpose one window on another. 

Some commands cause an additional window to be superimposed over the 
drawing or writing window — these will be considered later. 

The Desktop screen is divided into two windows. The upper window shows some 

of the folders and documents stored on one of the discs. The lower window 
shows the floppy and/or hard disc icons. 

The Desktop windows share certain features with the other windows in GEM. 

The MENU BAR is the strip along the top of the screen which displays the 
names of the menus: File, Arrange, Options and DESKTOP. The TITLE BAR 
reports the name of the folder which is currently open. 

In the top righthand corner of each of the windows is a diamond shaped box. 
This is the FULL SIZE BOX; clicking in this box will alter the size of the 
window from half screen to full screen, or from full screen to half screen. Try 

clicking in the full size box of one of the windows. Click again to return both 
windows to the screen. 

In the upper lefthand corner of each window is a ‘butterfly’ symbol. This is the 
CLOSE BOX; clicking in this box will close the folder and return the window 
which is one ‘level’ higher. On starting GEM, the upper window shows the 
contents of the GEMAPPS folder, displaying the applications icons. Click on 
the close box to close GEMAPPS; the window will be replaced by another 

window, displaying GEMAPPS as a folder. Clicking on the close box in the 
lower window will have no effect as the discs displayed are the top level of 
storage. 

There is a vertical strip down the righthand side of each window. When you 
start using GEM, this strip will be clear, but when you use a document or 
directory which is too large to be displayed in its entirety, the clear area will 
occupy only part of the strip and any part above or below it will be shaded. The 
clear area is the SLIDER; the shaded areas are the SCROLL BARS. The 
position of the slider indicates the location within the whole directory or 
document of the part which is currently visible. When the beginning of the 
document or directory is on the screen, the slider is at the top of the strip. The 
size of the scroll bar beneath it indicates how much of the document or directory 
is not visible, as the relative sizes of the slider and scroll bars are directly 
proportional to the volume of the document or directory visible and not visible



at any time. To move to a different area of the document or directory, drag the 
slider up or down, Alternatively, click on the scroll bars or the arrows at their 
ends to move through the document by increments. Clicking on the scroll bars 

moves through the document more quickly than clicking on the arrows. 

2.8 Icons 

An ICON is a picture representing an item on the Desktop — a floppy or hard 

disc, folder, document or application. 

The icons displayed in the lower window represent two floppy discs and a hard 
disc. The floppy discs are referred to as A and B; the letter indicates which drive 
the disc is in (A: or B:). The hard disc is referred to as C. 

The icons displayed in the upper window show folders and documents. If you 
clicked on the close box, one of the folders displayed will be named “GEMAPPS”, it 
contains the GEM applications Write and Paint. When you have created some 
documents, the icons representing them will illustrate whether they are text or 

graphics documents. 

Using just the pointer and icons it is possible to SELECT an item, to OPEN or 

use it, or to copy it. 

An item is selected by clicking on its icon. Once you have selected it, you can do 

something with it — for example, choosing a command from a menu which will 
then operate on the selected icon. To DE-SELECT an item without using it, 

simply click on an empty part of the screen. 

An icon is selected and opened by double-clicking on it, or by selecting it and 

then using the Open menu comman4d, or by clicking on it and then using the 

[Return] key on the keyboard. 

To move or copy the contents of a disc, folder or document, drag the appropriate 
icon to its new destination. This is primarily a Desktop technique, and will be 
considered in more detail later (5.4).



2.9 Opening an Application or 
Folder 

To use an application or examine the contents of a folder it is necessary to 
OPEN it. Opening a folder replaces the window in which the folder appeared 
with one showing the contents of the folder. Opening an application loads and 

runs that application. Opening a disc displays the top-level folders held on that 

disc. 

A disc, application or folder can be opened by double-clicking on the appropriate 
icon, or by selecting the icon and then clicking against the Open command in 

the File menu (see 2.10). Try opening GEMAPPS by double-clicking on its icon. 

The window is replaced by that displayed when you entered GEM, showing the 

contents of GEMAPPS. Now the icons include the GEM Paint folder — which 
shows a picture of a palette - and the GEM Write folder - which shows a 
picture of a typewriter. If you double-click on either of these, the application 

will be opened and will replace the Desktop. Click on the close box (the butterfly 
symbol in the upper lefthand corner) to close the folder again. 

2.10 Menu Commands 

The menus used by GEM are called DROP-DOWN menus because they drop 
down from a bar across the top of the screen (the MENU BAR). Moving the 
pointer into the menu bar and over the name of a menu causes that menu to be 

displayed. When a new menu is called up, the last one is removed from the 

screen, To remove a menu from the screen without selecting a command, click 

anywhere else on the screen. 

To use one of the menu commands, click on the appropriate line of the menu. 
For example, click on the clock option in the DESKTOP menu (on the 
righthand side), and the clock accessory will appear on the Desktop. To remove 
the clock, click on its close box. 

Some of the menu commands require that an icon or a group of icons is selected 

before the command can be used. These lines appear in faint type when no icons 
are selected, indicating that they cannot be used. If you click on one of these 

lines, the command will be ignored and the menu will disappear. To test this, 
display the File menu and click on the Open command. Now select the 

GEMAPPS icon and display the File menu again; this time, the Open



command is visible. If you click on Open, the initial window showing the 
contents of GEMAPPS will be restored. 

The only menu commands which you will need to use at this stage are: 

Open in the File menu 
Exit to DOS in the File menu. 

Exit to DOS leaves the GEM software suite and returns to DOS, the Operating 
System. Type GEM or press [10] to re-enter GEM and restore the Desktop. (Type 
NOTUBE and press the [retuaN] key to return to the BBC Master Series, 
bypassing the Tube.) 

You may wish to use the desk accessories; these are opened from the Desk 

menu, and are discussed in 2.13. 

The other menu commands are concerned with Desktop procedures, and are 
discussed in Section 5. 

2.11 Dialogues 

Many of the menu commands in the GEM applications, and some other 
operations, require that you make a choice between two or more options. The 
options are offered in the form of a DIALOGUE. A dialogue is a rectangular box 
superimposed over the picture on the screen; it has a series of boxes, each 
displaying a possible choice, sometimes a line for text, and boxes labelled OK 
and Cancel. To make a selection, type any necessary text and click on the 

appropriate box or boxes. 

The most simple form of dialogue offers only the OK and Cancel boxes, asking 
you to confirm a command or to abandon it. Other dialogues offer several 
choices, or allow you to set several options at once. The boxes showing the 
current settings are highlighted; to change the settings, click on the required 
options and then either click on OK or press the key on the keyboard. 
Pressing the key is equivalent to clicking on OK in any dialogue. To 
reject the new settings, click on Cancel and the original settings will be 
retained. 

A second type of dialogue has a TEXT FIELD so that you can type in text (the 
name of a folder or document, for example). 

To display a dialogue of each type follow these instructions: 

a. Click on the Set Preferences command in the Options menu; the following



dialogue is displayed: 

SET PREFERENCES 

Confirm Deletes: Yes No 
Confirm Copies: Yes No 

Double-Click Speed: Slow 2 3 4 Fast 
Sound Effects: On Off 

OK Cancel 

The highlighted options are those currently set. Click on Cancel. 

b. Double-click on the New Folder icon; the following dialogue is displayed: 

NEW FOLDER 

Name: | — 

OK Cancel 

Type a name up to eight characters long (using the [pevete] key if necessary), 

and press [Retuan] or click on OK to create the folder. Click on Cancel to 
abandon the command. 

Sometimes GEM issues messages providing information. This occurs if you 

request something which is impossible, or sometimes if you make a mistake. 

The message is a type of dialogue. It requires that you click on OK to confirm 
that you accept the message and its implications, or sometimes on Cancel to 
abandon an impossible command. 

2.12 Item Selector 

The ITEM SELECTOR is a box which appears superimposed over the window 
whenever you issue a command which requires a choice of folder or document 
to be made, or a name for a new document to be supplied. 

The item selector is similar to a dialogue. It lists the names of documents and 
folders contained in the folder currently open. It has OK and Cancel boxes. 

An example of an item selector is illustrated on page 15. This example offers 
different documents available within Paint. The name currently selected 
appears in the text field. To select an item, click on the appropriate line; the



name will be highlighted. To confirm your choice, click on the OK box. You can 
also select an item by double-clicking on it, or by typing its name in the text 

field (the letters will automatically appear in the line marked Selection: ) and 
clicking on the OK box. Pressing the [aeTuay] key has the same effect as clicking 
on the OK box. 

‘The item selector has room to display only nine names, although it is possible to 
have many more documents than this within a folder. In such a case, only the 
first nine titles are displayed (they are arranged alphabetically). To select an 
item which is not displayed, use the slider and scroll bars to move through the 
list until the required name is visible, then click on it. Drag the slider up or 
down to display higher or lower sections of the list, or click on either the arrows 
or the scroll bars to move by increments through the list. 

When you have created some documents and built up a directory path 
structure (explained in Section 5.2), you may want to select an item which is 
not listed in the item selector because it is not held in the folder which is 
currently open. In this case, move the pointer to the line showing the path 
name of the folder and click once, then type the directory path name and the 
title of the document, using the [pecete] key if necessary. To clear the whole line, 
press the key. Alternatively, click on the close box of the item selector 
to move up the directory path until the relevant folder name is displayed. Click 
on this, and when the contents of this folder are listed, click on the appropriate 
folder or document name. Continue to move through the directory path until 
the document name is displayed, then select it in the usual way. The item 
selector only lists documents of the type indicated by the suffix in the directory 
path line. If the last part of the name is *.DOC, only .DOC documents in the 
open directory will be listed. 

Clicking on the close box of the item selector shown on the next page would 
display the options 

DOCUMENTS 
IMAGES 

Clicking on DOCUMENTS would list folders and any documents suitable for 
use with Paint available in the DOCUMENTS folder. If you had not yet created 
any more folders or any graphics documents with the suffix IMG in 
DOCUMENTS, the only available folder would be 

TUTORIAL 

Clicking on TUTORIAL would display any documents with the suffix .IMG in 
that folder; as the folder does not contain any .IMG documents, the directory 
would be empty.



1B SELECTOR 
Hi irectory:_B:\ LAKES I 

z 

  

2.13 Desk Accessories 

The DESKTOP menu includes the options 

Calculator 
Clock. 

These are DESK ACCESSORIES; these examples are equivalent to the 
accessories you might have on a real desk, and behave in the same way. The 
other accessories supplied as standard are Snapshot and the Print Spooler. 
These use documents, and will be considered later. (For details of the Snapshot, 
see 3.7.7; for details of the Print Spooler, see 4.6.7 or 6.6.4.) Additional 
accessories may be obtained and installed. 

GEM has only a limited amount of memory which can accommodate 
accessories; it cannot accommodate all of those which are available. You will, 
therefore have to choose which ones to install. Contact an Acorn dealer for 
details. 

To use an installed accessory, click on the appropriate menu line. To remove an 

accessory, click on its close box. The accessories may be moved about the 

screen. To move an accessory, drag the title bar (the shaded bar along the top in 

which the name of the accessory appears) to the new position. To drag the title 
bar, move the pointer into the title bar, press down the mouse button and move 
the pointer. An outline rectangle moves with the pointer as a guide to the area 
the accessory will cover. Keep the button pressed until the outline is where you



want it. When you release the mouse button, the accessory will appear at the 
new location. 

2.13.1 The Calculator 

Click on the Calculator command in the Desk menu. When the calculator 
appears, try dragging it to a different place on the Desktop. 

Calculations are performed by clicking over the appropriate symbols and 
numbers, or by entering these at the keyboard, or a combination of both. The 

characters +, -, *, /, % are used for addition, subtraction, multiplication, 

division and calculation of percentages respectively. The ‘change sign’ 

operation represented by +\— on the calculator is obtained from the keyboard 

by using the backslash (\) character. The M+ and M~ functions (add to or 
subtract from the memory) can be achieved from the keyboard by typing M+ or 

M-. The numbers input appear in the calculator’s ‘display’ area above the 

‘buttons’. Click on = or press = to display the result. 

There are two ‘Clear’ buttons, EC and C. EC clears the last entry but does not 

abort the current operation. For example, the sequence 

45 + 10 EC 15 

is equivalent to 

45 + 15. 

C clears the display and terminates the current operation. 

2.13.2 The Clock 

‘The clock is a twelve-hour clock; am or pm is displayed to the right of the time. 

Because the microcomputer has a ‘real time’ clock built into it, it should not be 
necessary to set the time on the clock. However, should you wish to set the 

time, the procedure is as follows: click on the clock symbol to the left of the 
display to enter the time-setting mode; click on the hours or minutes figure and 

then type in the number of hours or minutes as a two-digit number at the 

keyboard. Only two-digit numbers will be accepted (01 to 12 for the hours, 01 to 

60 for the minutes). Click on am/pm to change its setting. 

  

You can use Sections 3, 4 and 5 in any order. It may be best to turn first to 
either Section 3 or Section 4 to create some documents using Paint or Write.



3 GEM PAINT 
  

3.1 Introduction 

GEM Paint is a versatile and exciting graphics program. Using Paint, it is easy 
to create colourful images incorporating automatically generated patterns 
(which you can design yourself), regular and irregular shapes, and lines of 
different widths and styles. 

GEM Paint provides facilities equivalent to ordinary painting techniques. 

There are ‘brushes’ of varying thicknesses and shapes, different colour ‘paints’, 

an ‘airbrush’, a ‘pencil’, and an ‘eraser’. But in addition, Paint offers much more 

than the conventional paintbox. Regular and irregular geometric shapes can be 

generated easily; parts of the painting can be moved or copied after they have 
been created; sections can be moved or copied onto and from other paintings; 
areas can be flooded with a colour or a regular pattern; a section can be 
magnified, allowing you to work on it in detail. 

Paint is very easy to use. The simplest way in which to become familiar with its 

capabilities is to experiment freely. This section introduces Paint, but you will 

learn through experience and exploration how best to use it. 

3.2 Selecting GEM Paint 

Beginning from GEM Desktop, open Paint by double-clicking on its icon (called 
PAINT.APP) or by clicking once on the icon and selecting Open from the File 
menu. The Paint screen will be displayed; it is illustrated on the next page. 

Documents created in Paint are automatically given the suffix .[MG to identify 

them as pictures. The icon used on the Desktop to illustrate Paint documents 
shows that these are pictures, making them readily recognisable.



  

3.3 The Paint Screen 

The Paint screen is illustrated above. Like the Desktop and Write screens, it 
has a menu bar along the top and a title bar beneath this. Every time you 
create a new picture, the title bar reports that the painting is Untitled until it 

is saved and given a name. When a picture which has previously been saved is 

recalled, its title appears, together with the directory pathname, indicating in 

which folder or series of folders it is stored (see 5.2). 

A broad column down the lefthand side of the screen displays representations of 
options in Paint. The TOOLS PALETTE occupies the upper half of this, 

showing the fifteen tools available. Below this, the available colours are 

displayed in a strip called the COLOUR PALETTE. Beneath the colour palette 

are a scale and slider used to regulate the line width. The current line width is 

displayed and reported to the right of the slider. 

The column on the righthand side of the screen displays the PATTERN 
PALETTE. The large rectangle at the top of this column shows the currently 
selected pattern. Beneath this are seven rows of three boxes, each displaying a 

different pattern. Shapes drawn or flood-filled are filled with the current 
pattern. The airbrush and paintbrush also use the current pattern. 

The large blank area in the middle of the screen is the PAINTING SURFACE. 

Graphics may be drawn anywhere in this area.



Asin Write and Desktop windows, the close box is in the upper lefthand corner; 
the full size box and the size box are in the top and bottom righthand corners 
respectively. In addition to the vertical scroll bars and slider common to other 
GEM windows, Paint has horizontal scroll bars and slider. All these are used to 
control the size and content of the window. Their operation is described in 3.7.1. 

3.4 General Procedure 

This section describes how to select and combine the various facilities of Paint. 
An operation is suggested which demonstrates the action of each selection 

procedure; follow the instructions and observe the results on the screen. 

3.4.1 Default Parameters - Colour, Line Width, Pattern 
and Tool 

When you enter Paint, you can start to draw immediately. Move the pointer 

onto the painting surface — it changes shape. Press the mouse button and drag. 

Paint draws a line along the path of the pointer using a style and pattern which 

are automatically selected by the program. These are known as the DEFAULT 

settings because they are used by default, that is, if no other line width, colour, 
pattern or tool is chosen in preference to them. At the start of each Paint 
session, the default tool, the paintbrush, is highlighted on the tools palette; the 

default pattern is a solid colour (the default colour), and the default line width 

is 1. 

3.4.2 Selecting a Pattern 

The default tool, the paintbrush, uses a pattern rather than a colour. At the 
start of Paint, the current pattern is a solid block of the default colour. To select 
a new pattern, move the pointer onto the required pattern and click once. The 
new pattern will be displayed in the CURRENT PATTERN box at the top of the 
pattern palette. Any geometric shapes you draw using the tools in the bottom 

two rows of the tools palette will be filled with this pattern. Using the tap to 

flood-fill will cause areas of the painting to be filled with this pattern, and the 
airbrush will also use this pattern. 

It is possible to edit or re-design the patterns, and to store the new patterns for 
later use. This will be discussed later (3.6.4). 

The NONE pattern allows you to have no current pattern. When this is 

selected, geometric shapes will not be filled, the paintbrush will erase graphics 

in its path, and the tap and airbrush will erase areas of the picture. These 

effects are considered later. 
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3.4.3 Selecting a Tool 

Because the paintbrush uses the current pattern instead of a colour, and is 

unaffected by changes in the line width, it is necessary to select a different tool 
to observe the effects of altering colour and line width. 

To select a different tool, move the pointer onto the required tool and click once. 
The newly selected tool will be highlighted. The tools in the bottom two rows of 
the tools palette draw filled geometric shapes. The shapes drawn are always 
filled with the currently selected pattern. The pencil, eraser and airbrush 
operate in the same way as a conventional pencil, eraser and airbrush. The line 

tool draws straight lines, the ABC icon allows text to be added to the picture, 
and the tap floods a space with the currently selected pattern. The microscope 
magnifies a section of the painting and the broken rectangle is used to select 

areas which can then be moved, copied, inverted, etc. The operation of each of 
the tools is described in Section 3.5. 

3.4.4 Setting the Line Width 

The scale and slider beneath the colour palette are used to select a thicker or 
thinner line. Move the pointer onto the indicator on the scale and drag it up or 
down to decrease or increase the line width. Alternatively, click in the square 

box to the right of the scale to increase the line width by increments of 2. 

Shift-click on the box to decrease the width by increments of 2. The thickest 
line (at the bottom of the scale) has a width value of 29; the line width is always 

increased or decreased in increments of 2. A line of the current width is 
displayed to the right of the slider, and a number representing the width is 
reported below this. 

The line width set is used by the pencil, straight line and geometric shape tools. 

Change the line width and use the pencil to examine the effect. 

3.4.5 Selecting a Colour 

To select a different colour, move the pointer onto the required colour in the 
colour palette and click once. The current colour is used by the pencil and 
straight line tool, and for the outline of the shapes in the bottom two rows of the 
palette. Move the pointer back onto the painting surface and draw in the new 
colour using one of these tools. 
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3.5 The Tools Palette 

This section describes the operation of each of the tools in the tools palette. The 

tools in the bottom two rows will be considered first. 

3.5.1 Geometric Shapes 

The tools in the bottom two rows draw regular and irregular geometric shapes 
filled with the current pattern. The outline is drawn in the current colour; the 

width of the outline is determined by the currently selected line width. To draw 

a shape without a visible outline, set the line width to 0. 

The RECTANGLE tool at the start of the fourth row draws filled rectangles. 

Select the rectangle tool and position the pointer at the starting corner of the 

rectangle, then drag it to where you want the diagonally opposite corner to 

appear. As you drag across the screen, an outline of a rectangle moves with the 

pointer as a guide to the size and shape of the rectangle being drawn. Release 

the mouse button when the outline rectangle is the required size and shape. 
The rectangle is automatically filled with the current pattern. 

The ROUNDED RECTANGLE operates in the same way as the 

RECTANGLE, except that it draws rectangles with rounded corners. 

The QUADRANT at the beginning of the bottom row of tools draws quarters of 

a circle or elipse filled with the current pattern. The size and shape of the 

quadrant are defined by dragging the pointer. An outline arc appears, 

constantly showing the current size and shape of the quadrant during 

dragging. 

The CIRCLE draws circles or ellipses filled with the current pattern. To make a 

circle, the vertical and horizontal distances covered by the dragged pointer 

must be equal. If the pointer moves further across the screen than up or down 

it, a long horizontal ellipse will be drawn. Correspondingly, moving the pointer 

a greater vertical than horizontal distance will draw a taller ellipse. An outline 

of the shape being drawn appears as a guide. 

The POLYGON at the end of the fourth row draws polygons by linking straight 

lines defined by a series of clicks. Select the polygon, move the cursor to the 

starting point of the first side of the polygon and click. Then click for each 
subsequent corner (or vertex) of the polygon. Paint displays a line continuously 

to indicate the current appearance of the polygon between clicks. To complete 
the polygon, double-click, and the last vertex will be connected automatically to 
the starting point of the first line, and the polygon filled with the current 
pattern. (If the pattern set is NONE, the polygon will not be closed and filled.) 
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The CURVED SHAPE at the end of the fifth row draws free-form shapes. Move 
the pointer to the starting point of the shape, press the mouse button and drag 
to define the outline. When you release the button, the final point of the drag 
will automatically be joined to the first point by a straight line, and the shape 
filled with the current pattern. If the NONE pattern is selected, the shape will 
remain open and unfilled. The size of the shape will be limited unless the 
NONE pattern is selected. 

3.5.2. Painting Techniques 

The tools in the second and third rows offer different painting techniques. 

The PENCIL and ERASER operate in exactly the same way as their 

conventional counterparts. Select the pencil and draw some lines or shapes by 
dragging the pointer. Select the eraser and then drag the pointer across part of 

the painting surface. The painting beneath its path will be erased. 

The STRAIGHT LINE tool at the end of the second row draws straight lines. 
Click on the starting point for the line, move the pointer and click on the end 

point of the line, or drag from the start to the finishing point. The lines are 

joined only if the pointer is not moved between the end of one line and the 

beginning of the next. 

The PAINTBRUSH, AIRBRUSH and TAP all use the current pattern. 

Several shapes and sizes of PAINTBRUSH are available. Double-click on the 
paintbrush to display the alternatives. The current brush is enclosed in a 

rectangle. Click on the brush you want. (To keep the same brush, click inside 

the rectangle.) There is also a menu command to display the paintbrush shapes 

(see 3.6.2). 

The AIRBRUSH is similar to a conventional airbrush. As the pointer is 
dragged across the screen, a pattern of dots appears in its path. The colouring 
of the dots corresponds to an area of current pattern, but the density is not the 

same as if flood-fill was used, or a filled shape drawn. Covering the same area 

repeatedly will produce a more intense pattern, eventually giving full cover. 

The TAP floods a closed area with the current pattern. A single click identifies 
the area to be filled. The pattern will flow through narrow gaps but will stop at 
the borders of any closed shapes (or the edge of the painting surface). 

If the pattern is set to NONE, the tap erases blocks of pattern and the airbrush 
erases spots of pattern. 

3.5.3 Text 

‘The text tool is represented in the tools palette by ABC. After selecting the text 
tool, click on the painting surface to identify the starting place for the text. The 
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pointer changes to a vertical bar. Type the text you want using the keyboard in 

the usual way, and press the [Return] key at the end of the line. You can type as 
many lines as you like, and use the [netuaN] key to add blank lines. At the end of 
the text, press the [Retuan] key. You can move the cursor to a different position 

and resume typing text, or continue with other painting operations. 

  

The font (the style and size of letters) is set using the Typeface and Typestyle 
menus discussed in Section 3.6.5 and 3.6.6. 

3.5.4 The Microscope 

The microscope at the beginning of the first row of tools magnifies a small area 

of the screen for detailed work. After selecting the microscope, move the pointer 

until it is over the area you want enlarged, and click once. A rectangular area 
under the pointer is magnified and fills the whole painting surface. In the upper 
left of the screen, two small windows appear. The upper one shows the 
magnified area at its normal size. The position of the small rectangle in the 

lower window indicates the location on the whole painting of the magnified 
area. 

The magnified image on the painting surface consists of small blocks of colour. 

Each block is known as a PIXEL (— a PICture ELement). To edit the painting, 

click on single pixels and they will change to the current colour. If a pixel is 

already displayed in the current colour, it will not change. The effect of the 

changes on the appearance of the area at full size is visible in the upper 

window. 
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To move the microscope around the picture, drag the rectangle in the lower 

window. The upper window displays the area under the microscope as it moves. 

When the mouse button is released, the new area appears on the painting 
surface. Alternatively, use the sliders to move around the painting. (See 3.7.1 

for a reminder of the operation of the scroll bars and slider.) 

To return to the full-size painting, click in the upper window. 

3.5.5. The Selector 

The rectangle drawn in a broken line in the first row of the Tools Palette is the 
SELECTOR. It is used to select an area of the painting which can then be 
edited using commands from some of the menus, moved or copied. 

To select an area of the screen, click on the selector, and then define a rectangle 

by dragging the pointer from one corner to the diagonally opposite corner. A 

guiding rectangle is displayed, indicating the area currently selected during the 
drag. 

When you release the button, the selected area is enclosed in a rectangle drawn 
in a broken line. The segments of the line alternately flash on and off, giving 
the effect of a ‘blinking’ line, 

When the pointer is inside the selected area, it changes to a hand. To COPY the 
selected area, drag from anywhere inside the box to the place on the painting 
surface where you want the copy to appear. To MOVE the selected area, hold 
down the key on the keyboard while dragging the box. A copied area can 
be moved without holding down the [erat ] key; move the pointer back into the 
copied area and drag it to a new position. 

  

Several operations offered in the menus require an area of the painting to be 
selected before they can be chosen. These are discussed in 3.6.3. 
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3.6 Menu Commands 

The illustration of the Paint screen at the start of this section shows the 
location of the different menus in the menu bar. This subsection briefly 
describes the commands available in each of the menus, 

Commands which appear in faint letters on the screen are not currently 
available. In Paint, this is often because an area of the picture must be selected 

before the command can be used, but it may be for some other reason. For 
example, if the painting is new and therefore has no title, the Save command in 
the File menu is not available; when a painting already has a name, this 
command appears in normal type. 

3.6.1 File 

The File menu offers the following commands: 

New 

Open... 

Close 
Save 
Save as... 
Abandon 
To Output... 

Quit 

New - starts a new painting, replacing the current painting. Any picture 

already on the screen will be lost unless you first SAVE it. The following 
dialogue is issued as a warning: 

Abandon edited image? Yes 
No 
Cancel 

Yes — deletes the painting. 

No and Cancel — return to the painting session, aborting the New command. 

Open... — opens another painting which has previously been saved. This can 
be used to display a picture on a clear screen, or to open a painting in an 

additional window (see 3.7.2). The item selector is displayed when this 

command is chosen; click on the name of the required picture, or type in its 

name (and directory path name if necesary). You can use the slider to move up 

and down the directory if more documents are held in the folder than there is 
room to list. Use the close box to move through the directory path. (An account 
of pathnames and directories is given in GEM Desktop, 5.2.) 
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Close — closes the current painting. The Abandon edited image? dialogue is 

issued asking you to confirm the action. 

Yes — abandons the painting without saving the changes. 

No — saves the painting under the same name, preserving any changes made 
to it in the session. 

Cancel — returns to the painting session. 

Save — stores the changed picture under its original name, replacing the 
previous saved version. The painting remains on the screen and the session can 

continue. 

It is advisable to save the image intermittently during a session. If a recent 

version has been saved, any mistakes you make, or a power or computer 

failure, will not necessitate re-creating the whole painting. 

Save as... — stores the picture under the name you supply when the item 

selector appears. This can be used to save a second version of a picture that 

already has a name without overwriting the original version. If a document 

with the same name already exists, a dialogue offers you the opportunity to 

confirm or cancel the command before the original document is overwritten. 

Abandon — removes the current painting without saving it. If the painting 

was untitled, the painting surface is left blank; if the picture has been 

previously saved, that version of the painting is restored to the screen. As a 

safety precaution, the Abandon edited image? dialogue is displayed, allowing 

you to confirm or cancel the Abandon command. 

Yes — abandons the changes to the painting, restoring the original state of the 
painting, or clearing the painting surface, 

No and Cancel — return to the painting session. 

To Output... — enters the Output system allowing you to send an image of 

the picture to the screen or printer. If the current version of the painting has 

not been saved, the Abandon edited image? dialogue is displayed, as entering 

the Output system removes the painting from the screen. 

Yes — enters the Output system. 

No — displays the item selector so that the painting may be saved. 

Cancel — returns to the painting session. 

Details of the Output system are given in the Output Guide, Section 6 of this 
manual. 

Quit - returns to the Desktop. The Abandon edited image? dialogue is 
displayed if the painting has not been saved. 
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3.6.2. Tools 

The Tools menu offers the following commands: 

Keyboard equivalent 

Undo 
Grid On/Off 
‘Transparent On/Off 

Brush Shape... 
View Picture... 
Size Picture... 

Undo — cancels the last operation, with some exceptions. Undo cannot be 

cancelled itself; text cannot be cancelled after the [RETURN] key has been pressed; 
no more than one instance of any operation is cancelled — that is, if you have 

drawn three rectangles, Undo cancels only the last one. 

Pressing the key has the same effect as Undo. 

Grid On/Off — turns on or off Paint’s invisible grid. The invisible grid is made 

up of points approximately a quarter of an inch apart. When the grid is turned 

on, some graphics operations ‘snap’ to the grid point nearest to any position 

supplied. This helps to align parts of the painting more closely than is possible 

judging positions by eye. When the grid is turned off, the exact position under 

the pointer is taken as the starting point for the graphics produced. 

Transparent On/Off — turns on or off the transparency of colour blocks. 
When transparent is on, any pattern or colour behind another block is partially 
visible. When transparent is off, all blocks are completely opaque. Changing 
the transparency setting does not affect the appearance of the picture already 
on the screen. 

Brush Shape... — displays the available brush shapes, a range of sizes and 
shapes. The current brush is enclosed in a rectangle. To select a different brush, 

click on it; this brush shape will be used whenever the paintbrush is selected. 

The brush shapes are also displayed if you double-click on the paintbrush in the 
tools palette. 

View Picture... — superimposes a small window showing the whole 
painting. Inside the superimposed window, a rectangle indicates the area of the 
painting which is currently displayed on the painting surface. To display a 
different area of the painting, drag the rectangle to cover the required area. 

When you release the button, the newly selected area will be displayed. 

Size Picture... - displays a dialogue offering different picture sizes: full, 
half, or quarter size, or as much as will fill the screen. The command deletes the 
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picture from first the bottom and then the right. The reduction cannot be 
reversed; if the picture is not already saved, the full picture will be permanently 

lost. 

3.6.3 Selection 

The Selection menu offers the following commands: 

Clear 
Complement 
Flip Horizontal 
Flip Vertical 

All these commands require that an area of the painting surface is selected (see 
3.5.5). 

Clear — clears all graphics from the selected area. 

Complement — reverses the colours in the selected area. If transparency is 
set ON, the selected area will consequently appear black. 

Flip Horizontal - turns the graphics in the selected area around 
horizontally. 

Flip Vertical — turns the graphics in the selected area around vertically 
(turns the image over). 

3.6.4 Patterns 

The Patterns menu offers the following commands: 

Hide/Show Patterns 
Make Pattern 
Edit Pattern... 
Save Patterns... 
Load Patterns... 

Hide/Show Patterns — hides or shows the pattern palette. By default, the 
pattern palette is shown, and the menu then displays the Hide Patterns 

option. If this command is selected, the pattern palette is hidden, and the menu 

command displayed is the Show Patterns option. With the pattern palette 

hidden, you can draw over this area, but not select patterns. 

Make Pattern — creates a new pattern from an area of the painting and adds 

it to the pattern palette, replacing an existing pattern. 

Click on the pattern in the palette which is to be replaced, making this the 
current pattern, then click on the selector. Paint uses an area 16 pixels square 
for the new pattern; identify the area to be used by clicking over the position for 

the top lefthand corner of the square. The selected area will be enclosed in a 
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‘blinking’ rectangle. Choose the Make Pattern command, and a pattern made 
by repeating this area will appear in the current pattern box, replacing the 
previous current pattern, and in the small box of the pattern palette originally 

occupied by the other pattern. 

The new pattern will be lost at the end of the Paint session unless you save it 

using the Save Patterns . . . command. 

Edit Pattern... — allows a pattern in the pattern palette to be edited. Click 
on the pattern to be edited, making it current. When you select the Edit 
Pattern command, a window will appear superimposed on the picture showing 
an area of the current pattern and a blank area. Move the pointer over the 
blank area and observe the changes to the pattern area. The blank area 
corresponds to a pattern block; the pattern is made up by repeating this block. 

The available colours are displayed in a strip in the window; click on a colour to 

make it current. When the background colour is in use, the effects of moving 
the pointer are not visible in the drawing area, but the results of editing are 
continuously displayed in the pattern area. When the pattern is satisfactory, 

click on the OK box. Click on Cancel to return to the original pattern and 
remove the editing window. 

Double-clicking on a pattern has the same effect as choosing the Edit 
Pattern... command. 

An edited pattern can be saved for later use by the Save Patterns... 
command. 

Save Patterns... — saves the current pattern palette on disc so that it can be 

recalled later. The item selector box appears; supply a name for the pattern file, 
which must end with the suffix .PAT (e.g. FRED1.PAT). The patterns can be 
recalled with the Load Patterns . . . command. 

The pattern palette used at the start of Paint is called MONO.PAT. To replace 

this with a different set of patterns, first save MONO.PAT under a different 
name and then save the new pattern as MONO.PAT. (This can be achieved 
most easily from the Desktop; see 5.5.1.) 

Load Patterns... — recalls a pattern palette saved earlier. When the item 

selector appears, click on the name of a saved pattern document (with the suffix 

-PAT) or type the name (and directory path name if necessary) in the text field. 
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3.6.5 Typeface 

The Typeface menu offers the typefaces and point sizes available for text. The 

currently selected style and size are marked. 

system font 

Swiss 
8 point 

10 point 

14 point 

16 point 

18 point 

20 point 

28 point 

36 point 

The higher the number of the point size, the larger the letters appear on the 

screen. Not all sizes are available in each style. 

Always press the [Return] key after entering text; if you select a new typeface 
size or style after adding text and without first pressing the key, the 
program will attempt to overwrite the last piece of text in the new size or style 
and may produce messy results. 

3.6.6 Typestyle 

The Typestyle menu offers the typefaces and justification modes available for 

text. The currently selected style and alignment are marked. Changing the 

options does not change the appearance of text already on the picture, except 
that the last piece of text added will change if you have not pressed and 
have not carried out any other operation since typing in the text. Similarly, the 
colour of the last piece of text will change if you select a different colour after 
typing in the text and before pressing or carrying out another 
operation. 

Normal 
Bold 
Italic 
Underline 
Left Justify 
Center 
Right Justify 

Normal — unsets the selection of special features; text typed in will appear in 
normal typeface in the size and style selected from the Typeface menu. 

Bold — causes text input to appear in bold type. 
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Italic — causes text input to appear in italic type. 

Underline - underlines the text input. 

Left Justify - aligns text so that each line begins at the same position on the 

left (left-justification): 

These words are left-justified; the first 
letter of the second line is directly beneath the first 

letter of the first line. 

Center — aligns the text so that the centre of each line is at the same position 

(centre-justification): 

These words are centre-justified; they 
are aligned about the centre of each line, although the lines are 

of different lengths. 

Right Justify — aligns text so that each line ends at the same position on the 
right (right-justification): 

These words are right-justified; all the lines end 
at the same righthand position, although 

they begin at different positions on the left. 

3.6.7 PAINT 

The PAINT menu offers information about Paint, and the desk accessories: 

Paint Info... 
Snapshot 
Calculator 
Clock 
Print Spooler 

Paint Info... — reports information on GEM Paint. 

Snapshot — takes a SNAPSHOT of the painting and saves it on disc. A 
window is superimposed on the painting surface showing a camera and a 

question mark. Click on the question mark to see instructions on how to use the 
Snapshot accessory. Click on the camera to take a snapshot. The item selector 

appears for you to supply a name for the saved picture; this must have the 

suffix .IMG (e.g. CATS.IMG). When the item selector disappears, drag the 

cursor to define the rectangular area which will form the snapshot. The 

snapshot is taken when the button is released. The camera window reappears 

so that you can take more snapshots. To close the accessory, click on its close 

box. 
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Calculator — superimposes the calculator over the window. Instructions on 
using the calculator are given in 2.13.1, 

Clock — superimposes the clock on the window. Instructions on using the 
clock are given in 2.13.2. 

Print Spooler — displays the print spooler list, allowing document names to 
be added to or deleted from the list for printing. Only text documents can be 
sent to the print spooler. Instructions on using the print spooler are given in 
46.7. 

Note: All of the accessories may not be available (see 2.13). 

3.7 Windows 

3.7.1 Size and Position of the Window 

‘The size of the Paint screen can be altered using the size box and the full size 
box. The size box is the solid rectangle in the bottom righthand corner. To 

reduce the size of the window, position the pointer over the rectangle and then 

drag in towards the centre of the screen until the pointer reaches the new 

position for the bottom righthand corner of the window. To enlarge the window, 

drag the size box back out towards the bottom righthand corner of the screen. 

Click on the diamond shaped full size box symbol in the top righthand corner of 

the window to return the window to its full screen size, or to its most recent 
reduced size. Click repeatedly in the size box to reduce the size by a small 

increment. 

When a reduced size window is on the screen, only part of the picture may be 
visible. To view a part of the picture which is not contained in the window, use 
the scroll bars and sliders. These are situated along the bottom and down the 
righthand side of the window. The slider is the clear area in the middle of the 
strip. To move to another area of the screen, drag the slider in the appropriate 
direction or click on one of the arrows at the ends of the scroll bars to move by 
increments. For example, to move down the picture, drag the vertical slider 
downwards or click on the arrow at the bottom of the vertical scroll bar. To 
move across the picture to the right, drag the horizontal slider to the left, or 
click on the arrow at the left of the horizontal scroll bar. When you release the 
button, the newly selected area of the painting will appear. If the slider is at one 
end of the strip, you have reached the edge of the picture. If it occupies the 
whole strip, the entire picture is visible. 

To move a window, drag the title bar to the new position. 
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3.7.2. Using an Additional Window 

It is possible to display and use two paintings at once. To open another painting, 
select the Open... command from the File menu (see Section 3.6.1) and 
choose another painting. It will probably be necessary to reposition one or both 

windows and alter their sizes so that both are visible at the same time. Sections 
can be copied or moved from one window to the other. 

Sections are moved or copied between windows in the same way as within a 

single window. The area is selected using the selector and dragged to a new 
position. If the [ctrt ] key is held down, the area is moved; if not, it is copied. 

One window is always ACTIVE; this is displayed over the other painting and is 

the one you can work on. To make a window active, click anywhere inside it. 

When two windows are displayed, the title bar of the active window is 
highlighted. 
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4 GEM WRITE 
  

4.1 Introduction 

GEM Write is a versatile word-processing program which is very easy to use. 

Unlike many word-processing systems, it does not require you to remember 

sequences of combined keystrokes to invoke the various operations available. 
Instead, all the operations are displayed on the drop-down menus and are 

selected by clicking. However, if you prefer to use keystrokes, many of the 

keystrokes used in WordStar and Volkswriter are recognised by Write 
(see 4.8). 

The most innovative feature of GEM Write is its link with GEM Paint, enabling 

graphics to be added to the text. A picture drawn with Paint can easily be 
inserted at any point into a document written with Write. This makes it 

possible to create impressive and attractive illustrated documents very simply. 

A tutorial in three parts is supplied on the GEM discs. This introduces and 
explains the facilities available within Write. This manual provides a backup to 
the tutorial, and can be used for reference, but you should use the tutorial to 

learn how to use Write. 

4.2 Starting GEM Write 

If you are using floppy discs, insert the Data disc into the second disc drive; 
close the door when the light comes on after selecting Write. 

Beginning from the GEM Desktop, open Write by double-clicking on its icon 
(WRITE.APP, illustrated with a typewriter), or by clicking once on it and then 
selecting Open from the File menu. The Write screen will appear. This is 

shown on the next page. 

Documents created in Write are automatically given the suffix .DOC to identify 
them as text documents. The icon used on the Desktop to illustrate a Write 
document shows ‘writing’ on a page, identifying it as a text document. 

The first time you use GEM Write, the following dialogue will appear: 
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WELCOME TO GEM WRITE! 

Please enter the following so that GEM Write can be personalized 

for your use. 

My name is: | 
My system has 

Floppy Disks: 1 2 

Hard Disk Yes No 

OK 

Supply the information required and click on OK to start Write. 

4.3 The Write Screen 

The Write screen is illustrated below. Like the Desktop and Paint windows, it 
has a menu bar along the top and a title bar beneath this. Every time you 
create a new document, the title bar shows that the document is Untitled until 
it is saved and given a name. When a document which has previously been 
saved is recalled, its name, including the directory path name, appears in the 
title bar. The directory path name indicates where the document is stored (see 
5.2). 

al 
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Aslider and scroll bars down the righthand side of the screen allow you to move 
up and down through the document. When you start a new document, the 
slider occupies the whole of the strip, indicating that all the document is 

displayed on the screen. 

The symbol in the lower righthand corner is the size box. Drag the size box to 

modify the size of the window, or click on it to reduce the size by increments. 

Click on the full size box in the upper righthand corner to restore the window to 
full size. If you click on the full size box when the window is at full size, it will 

return to its most recent reduced size. 

The CURSOR is the flashing bar which is initially located in the top lefthand 
corner of the writing area. This indicates the position at which text or 
modifications to the text will appear. It can be moved around the screen to 
insert, move, copy, edit or delete text. 

A bar along the bottom of the window, the STATUS BAR, reports the current. 

location of the cursor expressed as the page number and the number of the line 
on that page. Any messages issued by the Write program are displayed in this 
line. 

The cursor is at the top of the document when you create a new document. You 

can begin to type immediately. 

4.4 Using the Tutorial 

The Write tutorial is divided into three sections. The three parts are stored on 
the Data disc, and have the titles TUTOR1.DOC, TUTOR2.DOC and 

TUTORS.DOC. The tutorial documents are held in a folder called TUTORIAL. 

To load the first part of the tutorial, move the pointer over the name of the File 

menu so that this menu drops down, select the Open... command and, when 

the item selector appears, click on the line offering TUTORIAL. The diamond 
symbol to the left of the line indicates that this is the name of a folder. The 

contents of the Tutorial folder are listed in the item selector; click on 
TUTOR1.DOC to display the first tutorial document. 

If at any point you want to leave the tutorial, whether to use Write on your 
own, or to use another application, or to finish the GEM session, select the Quit 

command from the File menu. If you have altered the document, a dialogue 
appears warning that the document has not been saved; DO NOT SAVE THE 
‘TUTORIALS. The tutorials are already preserved on disc, and saving them 
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after editing them will destroy the original versions. Click on OK to close the 

tutorial document and return to the Desktop. 

4.5 Basic Techniques 

4.5.1 Moving the Cursor 

‘Text always appears at the position of the cursor, thus it is obviously necessary 

to be able to move the cursor around the document in order to edit the text. 
Most simply, if you make a mistake when typing in text, press the [oetete] key 
(next to the [sHiFt] key on the right). This deletes the last character typed and 
moves the cursor back one character. Holding down the foetete] key deletes 
characters rapidly as long as you hold it down. Very frequently, though, you 

will need to move the cursor to a different part of the document. 

To move the cursor to a part of the document which is visible on the screen, 

move the pointer to the appropriate position, and click once. The cursor jumps 

to the position of the pointer. Use the scroll bar to move up or down through the 
document to go to parts which are not immediately visible on the screen, then 
position the pointer and click as before. 

The arrow keys above the key move the cursor one character to the left, 
right, up or down. 

Several key combinations move the cursor automatically to positions in the 
document which may be useful. The following combinations use the arrow 

keys: 

Hold down [suit] and press[_7_] moves up halfa screen 
Hold down [shirt] and press[_I_] moves down halfa screen 

Hold down[crat Jand press[_t_] moves to line 1 of the last page 
Hold down [erat Jand press[_I~] moves to line 1 of the next page 

The keys in the following instructions are the numbers on the numeric keypad. 
Each key has a name; the number corresponding to the key name is given in 
brackets after the name. If at first the key does not perform the function, and 
numbers are inserted into the text, press the key. (The shift lock light 
should be off.) 

 



Press HOME (7) twice cursor moves to upper left 
of screen 

PressHOME ((7]) three times page 1, line 1 
PressHOME ((7]) thenEND (i) last page, end of last line 
Press HOME ((7]) then UPARROW ((e)) top of screen, same 

column. 
Press HOME ((7}) thenDOWN ARROW ({2}) bottom of screen, same 

column 

PressHOME (7) thenLEFTARROW (a) _ beginning ofline 
Press HOME (7) then RIGHTARROW (¢))  endofline 
Press HOME ((7}) then PAGE UP ((s}) upone screen 

PressHOME ((7]) thenPAGEDOWN  ((3]) downone screen 
PressEND (a) lower left of screen. 

4.5.2 Selecting Text 

Many commands offered in Write menus require that a portion of the text is 
selected. If no text is selected, these commands appear only in faint letters and 
cannot be chosen. 

There are three methods of selecting text: 

Move the pointer to the beginning of the passage to be selected and drag to the 
end. Releasing the button marks the end of the selected passage. As you drag, 

the selected text is highlighted; the selected passage remains highlighted after 
you release the button. 

OR 

Using the Function keys — these are the red keys along the top of the 

keyboard numbered [fo to [f9] . Move the cursor to the beginning of the passage 

to be selected and press the function key [fs]; all the text after the cursor 

becomes highlighted. Use the arrow keys to move the cursor to the end of the 

passage to be selected and press [16] ; the highlighting disappears from the text 

after the cursor. 

OR 

Move the pointer to the beginning of the passage to be selected, and shift-click; 
all the text after the cursor becomes highlighted. Move the pointer to the end of 
the passage to be selected and shift-click again; the highlighting disappears 

from the text after the pointer. 

The first and second of these options are most useful for selecting passages 
visible on a single screen. The first can be modified to select entire lines; move 
the pointer into the lefthand margin and move down to indicate which lines are 
to be selected. To select one line, click in the margin against the required line. 
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The third method is most useful for selecting text which covers two or more 

screens. The second method can also be used to select text over two or more 
screens. Move the cursor to the start of the text to be selected, press [fs], then 
display the Search menu and click on the Go To... command (see 4.6.3). 
Supply the destination page or line number and click on OK. When the page 
appears, use the arrow keys to move the cursor to the end of the selected 

passage, and press [16] . 
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4.6 Menu Commands 

Many of the commands offered in the menus can also be obtained from the 

keyboard, The combination of keystrokes required to invoke a menu command 

is indicated at the end of the menu line. Where the function key name is 
preceded by an arrow in the menu line, press the [suit] key down at the same 

time as the function key. Where it is preceded by a diamond symbol, press the 

[cory] key at the same time as the function key. Where it is preceded by the 
symbol *, press the [ctr] key at the same time as the function key. 

Using the keystroke combinations is exactly equivalent to selecting the 

corresponding menu commands. For example, [copy] and (12] pressed together 
are equivalent to selecting the Insert Text... command: the dialogue is 
displayed as when the menu is used. (Insert Text ... is in the File menu; see 

4.6.1.)



In the following descriptions of the menu commands, the keystroke 

alternatives are given to the right of the menu commands. 

4.6.1 File 

‘The File menu offers the following commands: 

Keyboard equivalent 

New (cera) 
Open... 
Insert Text... [cory] [12] 
Insert Graphics ... 

Save {q 
Save As... 
Abandon 
Print Draft [cory] [11] 
To Output 

Quit 

New — begins and displays a new, empty document. Any current document 

will be lost unless you save it first. A warning dialogue is issued to confirm loss 
of the current document: 

You have not SAVED the file you were OK 

editing. Changes made will be lost Cancel 
if you OPEN or start a NEW file. 

Open... — opens a previously saved document. The item selector is displayed 

when this command is selected. Click against the name of the document 

required, or type in the name, including the directory path name, if necessary; 

use the arrow and [oetete] keys to move to and edit the directory path name. Use 
the slider to move through the window if the folder contains more documents 
than there is room to list. Use the close box to move through the directory path; 
an account of pathnames and directories is given in 5.2. 

Insert Text... — inserts a text document into the current document at the 
position of the cursor. The item selector is displayed; click against the document 

required, moving through the window or directory path as necessary. The 
document selected must have the suffix .DOC. 

Insert Graphics... — inserts a graphics document into the current 

document at the position of the cursor. The document selected must be a GEM 

graphics document with the suffix .[MG. The item selector appears when this 
command is issued. Click on its close box to move up through the directory path 
until the folders DOCUMENTS and IMAGES are offered; click on IMAGES to 
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display a list of IMG documents and select one. 

The picture will either appear in the text, or shading and its title will indicate 

the area to be occupied by the picture. This depends upon the setting of the 
Turn Graphics On/Off command (4.6.5). The picture is printed when the 
document is printed, whether or not the graphics are set on. 

Save — saves the current document under the same name, overwriting the 
previous version. If the document is new, this command is not available. 

Save As... — saves a document under the name supplied. The item selector 
is displayed; supply a name for the document. The name may have up to eight 

characters, and must have the suffix .DOC to identify it as a text document. (If 
you give it a different suffix, GEM may be unable to save the format of the 
document properly, and you will not be able to insert the document into 
another Write document, or send it to the print spooler or output list.) You can 
use the Save As... command to save a second version of a document without 
overwriting the original version. 

To save part of a document, select the part of the text to be saved and then use 
the Save As... command; only the selected passage will be saved. 

Abandon - aborts the changes made to the current document and restores 
the most recently saved version to the screen. If it is a new document, it is 

deleted. A warning dialogue is issued to confirm the choice. 

Print Draft ~ prints a draft of the document without special text attributes 

(such as underlining) or pictures, but with HEADERS and FOOTERS (see 

4.7.3). The document is printed from the position of the cursor to the end. 

To Output — enters the Output system and creates an output file for the 
current document. The following dialogue is issued: 

Create .OUT file and start OUTPUT Start 
+ and stay in WRITE Stay 

Cancel 

Start — leaves Write, creates an output file and adds it to the Output list, and 

enters the output system. 

Stay — creates an output file and adds it to the Output list, but stays in Write. 

Cancel — remains in Write. 

The Output system is described in Section 6 of this manual. 

Quit — returns to the Desktop. A warning dialogue is issued to confirm exit 

from Write without saving the current document, as this will be lost. 
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46.2 Edit 

The Edit menu offers the following commands: 

Keyboard equivalent 

Insert Line [copy] [13] 
Center Line [copy] {t9} 
Delete Line crat | [14] 

Move [omy] i] 
Copy [cory] [16] 
Delete [copy] [ta] 

The last three of these commands operate on selected text; if no text is selected, 
the commands will not be available. 

Insert Line — inserts a blank line at the position of the cursor, moving down 

any text previously on that line. 

Center Line — centres the line on which the cursor is positioned between the 
set margins. 

Delete Line — deletes the line on which the cursor is positioned, moving the 

text below that line upwards. 

Move ~ moves the selected text, adjusting the position of the other text to 

accommodate it. The pointer changes shape to a vertical bar (called an 

I-BEAM) and a message appears in the status line: 

* Click on MOVE destination or click here to CANCEL 

Move the I-beam to the new position of the text, press down the mouse button 
and the I-beam changes to the INSERT CURSOR. Move this to the final 

position and release the button; the text moves to the new position. If the first 
line of a picture block is included in the selected text, the whole picture is 

moved. 

Copy — copies the selected text, adjusting the position of the other text to 

accommodate it if necessary. As with Move, the pointer changes to an I-beam 
and then the insert cursor appears when the mouse button is pressed down. 
The message 

* Click on COPY destination or click here to CANCEL 

appears in the status line. If the first line of a picture block is included in the 
selected text, the whole picture is copied. 

Delete — deletes the selected text and moves up the text below it. 
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4.6.3 Search 

The Search menu offers the following commands: 

Keyboard equivalent 

Find... 
Replace... 

Find Next (7 
Replace Next [r7) 

Go To... [orm] 

Find... — finds the first occurrence of a sequence of characters in the 
document. A dialogue appears; type in the string of characters to be sought and 

click on OK. (A string is any sequence of letters, numbers, spaces and 

punctuation marks.) The cursor moves to the next occurrence of the string in 
the text. Select the Find Next command to move the cursor to the following 
incidence of the string. 

Only occurrences of the string which match exactly the sequence supplied to 
Find... will be identified; take care to use upper- and lower-case as 
appropriate. To find occurrences both with and without an initial capital, omit 
the first letter. For example, to find both ‘Typing’ and ‘typing’, supply yping as 
the string. 

Replace... — replaces one string of characters with another. The following 
dialogue appears: 

Find: | 
Replace with: 

Replace all? Yes No (Press #8 to stop) 

OK = Cancel 

Supply the first string, use the mouse, arrow keys or key to move to the 
second line and supply the string which is to replace the first. Then click on Yes 

to replace all occurrences of the first string with the second string, or on No to 

move from one incidence of the string to the next, optionally replacing each. 

The default is No. Click on OK to begin the operation, or on Cancel to cancel it. 

Unless you clicked on Yes, the cursor will move to the next occurrence of the 

first string. Select the Replace Next command to replace it, or the Find Next 
command to leave it unchanged and move to the next occurrence. You can 
interrupt the search to edit the text at any time. The replacement string will 
always appear in the same type style as that it replaces. 

To stop replacement of all occurrences of a string once begun, press the [fo] key. 
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Find Next — moves the cursor to the next occurrence of a string supplied to a 
Find ... or Replace... command. 

Replace Next — replaces the character string at the position of the cursor 

with the string supplied to the Replace... command. Use Replace Next 
without using Find Next to find and replace the next occurrence of the string 
in a single move. 

Go To... — moves the cursor to the page and line specified. When a dialogue 
appears, supply a page number, or a line number if pagination has been set 
OFF with the Format command in the Page menu (see 4.6.5). 

4.6.4 Font 

The Font menu offers the different type styles: 

Keyboard equivalent 

Normal 

Bold [sae] (77 
Italic [sHirr) [10] 
Underline [suet] [19] 

All these operate on selected text; if no text is selected, the commands are not 
available. The text remains selected after a change in style. 

Normal — returns the selected text to a normal type face. This has no effect if 

the selected text is already in normal type. 

Bold — changes the selected text to bold type. 

Italic — changes the selected text to italic type. 

Underline — underlines the selected text. 

46.5 Page 

The Page menu offers the following commands: 

Keyboard equivalent 

Turn Graphics Off/On 
Turn Auto-Reformat On/Off 
Turn Insert Mode On/Off 
Show Ruler 
Set Tabs & Margins... (s] 
Format... rat | [fi]



Turn Graphics Off/On — controls whether pictures are displayed or replaced 

by shading. When graphics are set ON, the menu offers Turn Graphics Off, 

and vice versa. Clicking on the command changes the setting, and the menu 

then displays the other option. 

When graphics are set OFF, the name of the picture precedes the lines reserved 

for it. You cannot write in or alter these lines. With graphics set off, the screen 

is redrawn more quickly than with graphics on. 

Turn Auto-Reformat On/Off — controls whether or not text is automatically 

re-aligned between the margins after insertions. When auto-reformatting is set 

ON, text is re-aligned at the next movement of the mouse, or click on the text. 
Clicking on the command changes the setting, and the menu then displays the 

other option. When auto-refomatting is set OFF, text is not re-aligned 

automatically. Each paragraph can be reformatted by positioning the cursor at 

the start of the paragraph and pressing the [1] key. Text will be reformatted up 

to the next { character. Press and [13] to make the paragraph markers 
(q characters) visible; press it again to hide them. 

Turn Insert Mode On/Off — controls whether text typed overwrites existing 

text or is inserted in front of it. When insert mode is set ON, the menu offers 

Turn Insert Mode Off, and vice versa. Clicking on the command changes the 

setting, and the menu then displays the other option. 

With insert mode set ON, the cursor appears as a vertical bar, and text typed is 

inserted immediately after the cursor. 

Show Ruler - displays the RULER marked with the tab positions and 

margins. The ruler is graduated, each position corresponding to a character in 

a text line. The diamond symbols mark TAB positions, the right angle bracket 

(>) marks the left margin, and the left angle bracket marks the right margin 

(<). The left margin is the position at which the text starts, the right margin 

marks the position at which the text line finishes. The TABS allow the text to 
be aligned in columns easily. Pressing the [tas | key on the keyboard causes the 
cursor to jump to the next tab position. For example, if a tab is set beneath the 

figure ‘1’ on the ruler (corresponding to the tenth character in the line) and the 

key is pressed when the cursor is at the start of a line, the cursor will 
jump to the tenth character position. 

The column in which the cursor is currently positioned is indicated on the ruler 

by a solid rectangle. If the righthand margin indicator is not visible, move the 
cursor to the end of the line to make it visible. 

When the ruler is hidden, the command reads Show Ruler; when the ruler is 
displayed, the command reads Hide Ruler. 

Whenever the ruler is displayed, tabs and margins can be set. When the pointer 
moves onto the ruler it changes to a hand. Tabs and margins are set in the 
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same way as when using the Set Tabs and Margins . .. command (below). 

Set Tabs and Margins... — allows tabs and margins to be set. The pointer 

changes to a hand, and a dialogue appears describing how tabs and margins 
can be set. Click over the character position in which a tab is required, either on 

the ruler or somewhere in the text. Click on an existing tab symbol to clear that 
tab. Drag the margin indicators to their new positions; during dragging the 
margin indicator is highlighted. When the tabs and margins are correct, click 
on OK. To restore the original tabs and margins, click on Cancel. 

Resetting the tabs and margins does not affect existing text. 

Format — displays the Format dialogue, allowing options to be set: 

PAGE FORMAT FOR OUTPUT 

    

Document mode: On Off 
Paginatio On Off 

Justificatior On Off 
Line spacing: 1 2 3 
Page length: 66 Lines 

Text begins o1 Be 
ends of i] 

Left margin: 5| characters 

OK Cancel 

The options have the following effects: 

Document mode - Off cancels auto- and manual reformatting, prevents 

paragraph markers being entered in the text when the key is pressed, 

turns off the Font menu commands and text selection. On restores these 
attributes. 

Pagination — controls display of the page number in the status line. If it is set 

On, the options Page Length, Text begins on and Text ends on can be used 

to control the format of the page. 

Justification — controls whether the text is right-justified (i.e. is aligned 
down the righthand margin). This affects printed text, but not the appearance 
of text on the screen. 

Line spacing — sets the line spacing to single, double or triple. 

Page length — sets the number of lines allowed for each page. (Set this to 
conform with the paper size used by the printer; 66 is a standard length.) 

Text begins on — sets the line at which printing will begin (not including any 
headers). The number of lines available for headers is determined by this 
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setting; for example, if the text starts on line 10, 9 lines of headers could be 
printed. 

Text ends on — sets the line at which printing will end on each page. The 
number of lines available for footers is determined by this setting and the page 
length. For example, if the page length is set to 66 and the text ends on line 60, 

6 lines of footers could be printed. 

Left margin — controls the character position at which text will start printing 
from the left. 

Click on OK when the options are correct, or on Cancel to retain the original 

settings. 

4.6.6 Options 

The Options menu offers the following commands: 

Keyboard equivalent 

Short Cuts... (nh) 
Set Preferences... 

Short Cuts... — displays a list of helpful shortcuts and explains the 

conventions used in the keystroke alternatives listed in the menus. 

Set Preferences... — displays the Set Preferences dialogue, allowing you 

to alter the program default settings (i.e. the actions which will be taken if no 
alternative is requested): 

SET PREFERENCES 

Turn Graphics: On Off 
Turn Auto-Reformat: On Off 
Create *.BAK files: On Off 
Delete *.OUT files: On Off 

Defaults for startup: 
Document Disk: B| 

Spilt-file Disk: B 

OK Cancel 

The options have the following effect: 

Turn Graphics On/Off - controls the display of pictures in the text or their 
replacement with shading. 

Turn Auto-Reformat On/Off — controls whether text is automatically 
reformatted within a paragraph after every editing command.



Create *.BAK files — controls whether, when a previously saved document 

is saved again, the previous version is stored with the file type .BAK as a 

back-up copy. 

This is a useful security precaution if it is possible that you will want to return 

to the original version, but uses extra disc space to store the additional version. 

Delete *.0UT files — controls whether the automatically created output file 

is deleted after printing. If you want to print the same document several times 

without changing it, it will be useful to retain the .OUT file (set Delete to 

OFF). Deletion of unnecessary output files saves dise space. 

Document Disk — indicates on which disc drive the documents are to be stored 
and sought. This will be B with a dual disc drive or C with a hard disc. If you 
have more than two disc drives, other options will be possible. 

Spill-file Disk — indicates on which disc drive the SPILL-FILES are 

stored. These are automatically created temporary files which hold parts of a 

document too large to be stored in the computer’s memory. With a dual drive, 

this will be 8, with a hard disc it will be C. Enter X to prevent use of any 
spill-files. 

Do not change discs during an editing session, as the spill-files will be lost. If 

you change the spill-file drive it will be necessary to exit from GEM Write and 

restart it. 

4.6.7 WRITE 

The WRITE menu offers the following commands: 

GEM Write Info... 
Snapshot 
Calculator 
Clock 
Print Spooler 

GEM Write Info ... — displays copyright information about GEM Write; not 
all of this applies to the Acorn version. 

Snapshot — takes a snapshot of the screen and saves it on disc, giving it the 

document type .IMG. Details of how to use the Snapshot facility are given in 
Paint, 3.6.7. 

Calculator — superimposes the calculator over the window. Instructions on 
using the calculator are given in 2.13.1 . 

Clock — superimposes the clock over the window. Instructions on using the 

clock are given in 2.13.2. 
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Print Spooler — displays the Print Spooler list, allowing document names to 
be added to or deleted from the list for printing. To add a name, click on the 
Add box and the item selector appears; select the document to be added. Only 
text can be sent to the spooler; documents must have the suffix .DOC. To delete 
aname, click on the name and then on the Delete box. Documents are printed 

immediately, as soon as the item selector is removed from the screen. Printing 
is interrupted whenever the item selector is displayed. Text is printed in draft 
form, without special text attributes (bold type, underlining, etc.). Click on its 

close box to remove the spooler list. 

Note: All of the accessories may not be available (see 2.13). 

4.7 Embedded Commands 

EMBEDDED COMMANDS are commands typed into the text which control 

the presentation of the document on the page when it is printed out. They offer 

the facility to define HEADERS and FOOTERS (lines of text which appear 

above or below the main body of the text, such as running chapter headings or 

page numbers), to force a page break, to reset the page number counter, to send 

special command sequences to the printer, or to insert non-printing comments. 

Embedded commands are recognised by GEM Write as having a special status; 

they are not printed literally, and are not counted in the line count. 

Embedded commands are preceded by two full stops. They must begin in the 

first two columns of the text. They may be typed in upper or lower case. 

4.7.1 ..PAGE 

The ..PAGE command forces a page break. The new page will start with the 

next line of text. 

47.2 ..<comment> 

A comment may be inserted for reference while editing. It will not be printed. 

This may be useful for providing reminders, recording the date of a draft, etc. 

4.7.3 ..HEAD and .. FOOT 

The header and footer commands have the format 

+ HEAD <number >< letter><text> 

and 

«FOOT <number >< letter><text> 
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The number must be a two-digit number identifying the number of the line to 
be occupied by the header or footer. The number must fall within the lines 
allowed for printing headers and footers when the page format was set with the 

Format . . . command (see 4.6.5). The letter must be one of the following: C, L, 
R, A. This controls the alignment of the header or footer. C positions it 
centrally, L prints from the lefthand side of the page, R aligns the end of the 
header or footer with the righthand margin, and A aligns the text on the left 
and right alternately. The text supplied will appear literally, except that page 
numbers can be included by inserting two hash (#) signs in the text. For 
example, the command 

« -HEAD@3AChapter 1 — Page ## 

would print a header on the third line of every page, aligned alternately on the 
left and right, with the text 

Chapter 1 — Page <number > 

with the current page number inserted. 

The headers and footers will appear on the next page after that on which the 
command appears. List header and footer commands in the order in which they 
are to be printed (i.e. in consecutive order of line number), and insert them 
before other embedded commands where possible. 

4.74 ..PGNO 

The ..PGNO command resets the page number counter to the number supplied. 

The format of the command is 

--PGNO <number> 

The next page will have the number specified. 

4.7.5 ..CMD 

The ..CMD command sends a command code to the printer. The meaning of 

each command code will depend upon the type of printer in use; consult the 

printer manual to determine the functions of the codes which can be used with 

this command. 

4.7.6 ..GEM 

The ..GEM command is automatically entered by GEM when a picture is 
inserted into the text. It has the format 

«»GEM,<number>,<picture name> 

The number indicates how many lines the picture occupies. The picture name is 
reported in full, including the full directory path name and a letter identifying 
the dise drive. 
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4.8 Compatibility with other 

Programs 

GEM Write can be used with any documents in standard ASCII format, 

whether or not they were originally produced using Write. Select and open the 

document in the usual way using the item selector. However, the only graphics 

documents which can be inserted into Write text documents are those created 
in GEM (using GEM Paint or GEM Draw). 

Write acknowledges many of the most frequently used commands from the 
common word-processing programs WordStar and Volkswriter. A list of the 
keystrokes recognised by Write is given in one of the tutorial documents.



5 GEM DESKTOP 
  

5.1 Introduction 

GEM Desktop is an administrative and filing system. It allows you to move, 

copy and delete documents or folders easily, and to store your documents in a 

useful and logical order. 

To take full advantage of the facilities offered by the GEM package, it is 
necessary to form a structured filing system. You can either design a filing 
structure before creating documents and then give new documents names 

which will slot them directly into the right place, or you can create a filing 

structure and move existing documents into it. The first parts of this section 

are concerned with organising and creating a filing system. This includes an 

example you can re-create. 

The list or display of the contents of a folder which appears on the Desktop or in 

the item selector is called a DIRECTORY. Using the commands in the Desktop 

menus, you can control the way in which the Desktop displays directories and 

choose the icons it uses. 

5.2 Directory Paths 

The filing and adminstrative system offered by GEM is equivalent to a 

conventional office filing system, The elements of GEM’s filing system are the 

folder and the document (see 2.6). These are arranged inside each other to form 
a structure of folders, culminating in the final document. This enables 
documents (and folders) to be grouped according to their subject matter or 
contents. 

Each folder has a name; within a directory this name is sufficient to identify the 
folder. However, in order to represent the location of a document or folder 
within the whole filing system, it is necessary to supply the names of all the 
folders which must be opened to find it. This series of folders is called the 
DIRECTORY PATH. The full name of a document includes the directory path. 
The first element of a directory path name is a letter identifying the disc drive 

to be used; this is followed by a colon (e.g. B:). The folder names are given in the 
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order in which they must be openea, starung wiun tne vuvermuse wviues. Luc 

elements of the directory path name are separated by backslash characters ( \). 

The following is an example of a document name including the directory path 
name. 

Example: 

B:\SALES\ EAST\JONES\SAL1.DOC 

The parts of this name are: 

B:\ — the disc drive holding the disc from which the information was read. 

The folders displayed when you click on a disc drive icon are in the ROOT 

DIRECTORY. 

SALES\EAST\JONES\ — the directory path name; the folder JONES is 
held inside the folder EAST which is stored inside the folder SALES. SALES is 
in the root directory. 

SAL1.DOC — the document name, including the suffix .DOC which indicates 
that it is a text document and was created using GEM Write. 

Folders are frequently arranged in a tree-like structure; one folder will contain 
several others, each of these containing further series of folders. The directory 
path name maps out the route which must be taken through the structure tc 
find a document. The document in the example above might be part of @ 
directory structure like this: 

ww B NN. 

SALES RECEIPTS 

—_, 
EAST WEST  ISTQUART 2NDQUART 

es 
JONES SMITH — WALLIS 

SALLDOC SAL1.DOC SALI.DOC RECI.DOC REC1.DOC 
SAL2.DOC SAL2.DOC REC2.DOC 

Note that two or more documents may have the same name as long as they ar: 

not in the same directory.



To achieve the directory path illustrated you would need to create nine new 

folders. The creation of new folders is described in 5.3. You could either write 
the documents and supply their full directory path names to the item selector 

when saving them, or give each document a different name and copy them into 
the appropriate folders later from the Desktop. The first is the better method, 
but the second can be used to incorporate existing documents into a new filing 
structure. To supply a full directory path name to the item selector, move the 

pointer to the line displaying the directory path name and click. Then use the 
[oetete] key to delete elements of the path name which do not coincide with the 
name of the new document, and type the remainder of its directory path name. 

Press the key, and type the document name and suffix on the Selection 
line. Alternatively, click on the item selector’s close box to move back through 
the directory path, and then click on each folder in the directory path of the new 
document until the correct position in the filing system is reached. Type the 
document name in the selection line. 

5.3 Creating a New Folder 

To create a new folder, double-click on the New Folder icon. A dialogue will be 
displayed allowing you to name the folder. Type a name of up to eight 
characters in the editable text field, adding a three-character suffix if you want. 
The suffix is not necessary, but might be helpful if the folder is to contain only 
one type of document. After naming the folder, click on OK and the dialogue 
will disappear; an icon for the newly created folder will be displayed on the 
Desktop, with its name printed beneath. 

Documents or other folders can now be added to this folder. 

If you try to give the new folder the same name as an existing folder in the 
same directory, a dialogue will ask either for an alternative name or for the 
command to be abandoned. 

Example: 

To create the directory path illustrated in 5.2, follow these stages: 

Click on the close box until the disc icons are displayed, then double-click on 

dise B — this displays the root directory. 

Create a new folder and give it the name SALES. 

Create another new folder and give it the name RECEIPTS.



Double-click on the SALES icon to open the new folder. The folder is empty, 
but the New Folder icon is present to allow you to create more folders inside 

this one. 

Create two new folders, called EAST and WEST. 

Open EAST and create two new folders, called JONES and SMITH. 

Click on the close box; this returns the SALES directory. 

Open WEST and create a new folder, called WALLIS. 

Click on the close box to return the SALES directory and again to return the 
root directory. 

Open RECEIPTS and create two new folders called 1STQUART and 2NDQUART. 

Move through the directory path opening and closing folders to check that the 

structure is correct. 

5.4 Copying Folders and 

Documents 

If you have already created some documents using Paint or Write, use these to 

experiment with the techniques described here. 

To copy an item, drag its icon to the destination icon. When you begin to drag 

an item, the pointer changes to a hand; the hand must be directly over the 
destination icon when you release the mouse button. To check that the copy 
operation works, open a newly created empty folder (not one from the 

example). The window which appears should contain only the New Folder 
icon, as the folder just created is empty. Click on the close box to return to the 
previous window, and drag one of the other icons onto the icon of this folder. 
Unless Confirm Copies is set to NO (see 5.5.3), the COPY dialogue is displayed: 

COPY FOLDERS / ITEMS 

<number > 

<number > 

Folders to Copy:, 

Items to Copy: 

  

OK Cancel 

(The number of folders and items represented by the dragged icon is reported.) 
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When more than one item or folder is being copied, the dialogue constantly 
reports how many remain to be copied, counting down as copying progresses. 
Click on OK to start copying. 

When the dialogue disappears, open the new folder again; this time the copied 

icon appears in the new window. 

Several items can be copied at once. Hold down the [suit] key on the keyboard, 
or the righthand button on the mouse, and click on all the items to be copied. 
Without releasing the lefthand button on the mouse after the final shift-click, 
drag to the destination icon. The COPY dialogue appears and will report the 
progress of the copying operation, 

To make a duplicate of a folder or document without adding it to another folder, 

release the mouse button at the end of the drag over a blank area of the 

Desktop. It is necessary to supply a name for the new copy as two items of the 

same name cannot exist in the same directory. Try copying the newly created 

folder to a blank area. The following dialogue will appear: 

NAME CONFLICT DURING COPY 

  

Current Name: <name of folder> 
Copy's Name: . 

OK Cancel Stop 

Type a name for the new copy of the folder and click on OK or press the 
key. After the dialogue disappears, the new folder is visible on the Desktop. 
Open it to check that everything you added to the folder has also been copied to 
the new copy of it. Open the original version to check that copying does not 
alter the original. 

Copying an item to a disc icon saves the item on that disc. It will not be added to 
any folders, and will appear in the first window displayed when the disc icon is 

opened (the root directory). Copying a disc icon to another disc icon adds the 
data from the first disc to the second disc (if there is sufficient space free on the 
disc). Copying a dise icon to a blank area of the Desktop will not alone set up 

another disc drive; the Install procedure must be used to set up the Desktop for 

an additional dise drive (see 5.5.2). 

Example: 

Experiment with the capabilities of the Desktop by copying documents into the 
filing structure created in the example. Use both windows and copy documents 

between the two. 

Any documents you have already created are probably stored in one of the 
folders DOCUMENTS or IMAGES. Open one of these folders to display its 
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contents. Then open one of the folders JONES, SMITH, WALLIS, 
ISTQUART or 2NDQUART in the other window. Drag or shift-click and drag 
to copy items from the DOCUMENTS or IMAGES folder to the empty folder. 
Open other folders in the structure and copy documents into them. You can 

delete the original copies from DOCUMENTS or IMAGES later using the 

Delete command in the File menu (see 5.5.1). 

5.5 Menu Commands 

Many of the menu commands available from the menus on the Desktop are 

concerned with maintenance, administration and display of the filing system. 
Others are more general, such as those in the File menu and the accessories in 

the DESKTOP menu, which are common also to Paint and Write. 

Some of the menu commands can also be invoked by using combinations of 
keystrokes. In the screen menus and the following lists of commands, the 

keystroke equivalents are given to the right of the menu commands. On the 

screen menus, the diamond symbol indicates that the [copy] key must be held 

down while the other key is pressed. 

Some menu commands require an icon or group of icons to be selected. The 

commands appear in faint type and are unavailable unless an icon or group of 
icons of the correct type is selected. 

5.5.1 File 

The File menu offers the following commands: 

Keystroke equivalent 

Open 
Info/Rename... [cory] I 
Delete... [cory] 
Format... 
To Output 
Exit to DOS 

Open ~ opens the selected disc, folder, application or document. If a disc or 
folder is selected, Open displays a directory of its contents. If an application is 
selected, Open runs the application. 

Info/Rename ... — displays information about the selected item. For 
example, if the selected item is a folder, its name, its date of creation, details of 
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its contents and the number of bytes used by it are reported. (A BYTE is a unit 

of computer memory storage.) To rename a folder, click on the name, use the 

[octet] key to remove all or part of the name, type in a new name and click on 

OK or press [RETURN]. 

Delete... — deletes the selected item or group of items. Deletion is 
permanent; deleted items cannot be restored. You can select whether or not 

GEM asks for confirmation before proceeding with deletion; the default action 

(ie. that which it takes if the setting is not altered) is NOT to ask for 

confirmation. To change the setting, use the Set Preferences . .. command in 

the Options menu (see 5.5.2). 

  

Format... — formats the disc in drive B: (the second drive). A warning 
dialogue asks for confirmation, as formatting destroys all data on the disc. 

To Output — enters the Output system ready for printing, or displaying 

documents on the screen. The options available within the Output system are 
described in the Output Guide, Section 6 of this manual. 

Exit to DOS — leaves the GEM software suite and returns to the operating 
system. An A> prompt will appear. To re-enter GEM, press the red function key 

{fo] , or type GEM and press the [retuan] key. To leave DOS and return to the BBC 

Master Series bypassing the Tube, type NOTUBE and press the [Return] key. 

5.5.2 Options 

The Options menu offers the following commands: 

Keyboard equivalent 

Install Disk Drive ... 
Configure Application ... copy] A 

Set Preferences... 
Save Desktop v 
Enter DOS Commands copy] C 

Some of these commands require an item to be selected; they appear in faint 

type and are unavailable unless an item of the appropriate sort is selected. 

Install Disk Drive... — allows an additional disc drive to be installed, the 
description of an existing disc drive to be modified, or a disc drive to be 
removed. A disc icon must be selected. To add an additional disc drive, copy one 
of the disc icons and select the copy; to alter the description of a drive already 
represented on the Desktop, select its icon. A dialogue is issued when this 
command is selected; in this example, the icon for drive B: was selected. 
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INSTALL DISK DRIVE 

Drive Identifier:  B] Install 
Icon Label: FLOPPY DISK. Remove 

Icon Type: Floppy Hard Cancel 

‘Type a letter which will be used to identify the disc drive; this is usually A or B 
for a system with two floppy discs, or C for a hard disc. If you have more than 

two floppy discs, use any letter(s) for the additional drive(s). If appropriate, 
move the pointer to the next text field and click, use the [oetete] key to erase 
FLOPPY DISK, and then type HARD DISK. Click on Floppy or Hard as 
appropriate. Finally, click on Install to instal the newly described disc, 

Remove to remove the icon of an existing disc from the Desktop, or Cancel to 

retain the original status of the dise icons. 

Configure Application... — allows the information stored about 
applications to be altered. An application icon must be selected. A dialogue is 
issued which reports the selected application’s name, the document suffixes 
recognised for the application, the application’s type and whether it requires 
full computer memory to be run. The application type for the supplied 
applications is GEM. It is also possible to instal separately purchased DOS 

applications (e.g. WordStar). (DOS applications installed as DOS run as soon as 
selected; those installed as DOS-takes-parameters require additional 

information to be supplied — for example, the name of a file to be loaded.) 

A window shows the icons used to represent the application and the documents 

created by it. Use the scroll bars and slider to move through this window to 

select different icons to be used for the application and its documents. Type 
additional suffixes which you want GEM to recognise as identifying a document 

as created by the application. Click on Install to finalise the modification, on 

Cancel to retain the original description or on Remove to delete an application 

icon. You will not need to alter the other options unless you buy another GEM 
application. In this case, the new application will be accompanied by 

instructions on its installation. 

  

Set Preferences... — allows the default behaviour of the Desktop and its 

commands to be altered. The following dialogue is issued: 

SET PREFERENCES 

Confirm Deletes: Yes No 
Confirm Copies: Yes No 

Double-Click Speed: Slow 2 3 4 Fast 

Sound Effects: On Off 
OK Cancel



The highlighted options are those currently set. Setting Confim Deletes 

and/or Confirm Copies to Yes will cause GEM to issue a warning message 

whenever the command is issued asking for confirmation. It is advisable to set 

Confirm Deletes to Yes until you become familiar with the Desktop. The 
Double-Click Speed option enables you to alter the interval allowed between 
the two clicks of a double-click. Experiment with different settings until you 

find the one which suits you best. Click on OK to set the new preferences, or on 

Cancel to retain the original settings. The preferences will be reset to the 
original defaults on leaving GEM unless the Desktop is first saved. 

Save Desktop — saves the current state of the Desktop as the default. Every 

time the Desktop is displayed, it will show the directory displayed and use the 

defaults set with Set Preferences when it was saved. For example, opening a 

folder other than GEMAPPS and then saving the Desktop will cause the 

resultant directory to be displayed by default. However, any alterations made 

to the contents of a directory will be reflected each time the Desktop is 

displayed — so deleted items will not reappear, and new items will be shown. If 

the folder providing the directory is itself deleted, the default Desktop will show 

the disc icons until another Desktop is saved. 

Enter DOS Commands ~ allows commands from the operating system to be 
used. Details of the operating system can be found in Part 2 of this manual. 

5.5.3 Arrange 

The Arrange menu offers commands to control the form in which the Desktop 

directories are displayed: 

Keystroke equivalents 

Show as Text/Icons s 
Sort by Name [cory] N 

Sort by Type [cory] P 
Sort by Size [cory] Z 
Sort by Date [cory] T 

Show as Text/Icons — displays the directories as text or icons. The default 

action is to show the contents of directories as icons, and the menu offers Show 
as Text. Selecting this command displays a list of the names of folders, 
documents and applications in the current directory, with information about 
each item, and changes the menu command to Show as Icons. The order in 

which items in a directory shown as text are listed is controlled by the following 

commands. The current setting is indicated by an arrowhead to the left of the 
menu line. 

Sort by Name - lists items in a directory in alphabetical order. 
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Sort by Type - lists first folders, then applications, then documents. 

Sort by Size — lists items in order of size, measured as how many bytes of 
memory they occupy, beginning with the largest. 

Sort by Date — lists items in the order in which they were created, beginning 
with the most recently created. The date and time are given in the form 

<month>-<day>-<year> <hour>:<minute> <am/pm> 

Items in a directory displayed as text can be opened and selected in the same 
way as items shown as icons. 

5.5.4 DESKTOP 

The DESKTOP menu offers the following commands: 

Desktop Info... 
Snapshot 

Calculator 
Clock 
Print Spooler 

Desktop Info ... — displays copyright information about GEM Desktop. 

Snapshot — takes a snapshot of the screen and saves it on dise, giving it the 

document type .IMG. Details of how to use the Snapshot facility are given in 

Paint, 3.6.7. 

Calculator — superimposes the calculator over the window. Instructions on 

using the calculator are given in 2.13.1. 

Clock — superimposes the clock over the window. Instructions on using the 

clock are given in 2.13.2. 

Print Spooler - displays the Print Spooler list, allowing document names to 

be added to or deleted from the list for printing. To add a name, click on the 

Add box and the item selector appears; select the document to be added. To 
delete a name, click on the name and then on the Delete box. Click on its close 
box to remove the spooler list. Only text documents can be sent to the print 
spooler; they are printed in draft form (i.e. without special text attributes). 

Printing begins as soon as the item selector is removed from the screen (but is 

interrupted if it is restored to add more names). 

Note: All of the accessories may not be available (see 2.13). 
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6 OUTPUT GUIDE 
  

6.1 Introduction 

This Output Guide describes the functions and use of the GEM Output System. 

From the Output System, documents can be printed, displayed on the screen, or 
sent to a plotter. 

The Output System allows you to create a list of documents to be output (an 

OUTPUT LIST), and to select printing OPTIONS which control the way in 
which documents are printed or displayed. Both output lists and sets of options 
can be saved and recalled later for repeated use. 

All Output commands are selected from the menus. This Guide deals first with 
the possible output devices, then with the output lists and option selection, and 

finally reviews the menu commands. 

6.2 Connecting Output Devices to 
the Microcomputer 

Output of text or graphic documents to the screen is always available as an 
option. Documents can also be sent to a printer or plotter to produce a 
permanent copy on paper if you have these devices. Check that the printer 

and/or plotter is correctly connected before sending documents to it. 

6.2.1 Printer 

A printer for use with GEM must be an Epson FX80 or Epson-compatible 
printer with a parallel interface. (It is possible to run a printer on serial 

interface; contact an Acorn dealer for details.) Push the plug on the printer 

cable into the socket labelled Printer on the underside of the microcomputer. 
Align the projection on the plug with the notch in the socket; the plug will only 
fit one way. Ensure that the securing arms clip across the back of the plug. 
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6.2.2 Plotter 

It is possible to run a plotter from the Master Series BBC microcomputer, but 

this is not supplied or supported as standard; contact an Acorn dealer for 
advice. 

6.3 Entering the Output System 

Entry into the Output System is by selection of the menu command To Output 

from the File menu in one of the GEM applications or the Desktop. 

Starting from the Desktop, an empty output list will be displayed on the Output 
screen. 

Starting from one of the applications, an untitled output list is displayed with 
the document currently in use as the only entry. The Start Output... 

dialogue is superimposed over the list, allowing output to begin immediately. 
The Output screen is illustrated below. 

Tie 
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6.4 Output Lists 

An OUTPUT LIST is a list of documents to be sent to the printer, screen or 
plotter. The list has thirty-six lines to hold document names, but is subject to a 
maximum of 128 characters in total. In effect, this means that fewer than 
thirty-six names can be included; the exact number will depend upon the 
length of the document names. 

Names are added to the output list, and existing names are deleted or 

duplicated, using commands in the File menu. Only documents of certain types 
can be included in an output list; they must have one of the suffixes .GEM, 
-DOC or .IMG. Documents with the suffix .GEM are automatically created — a 
.GEM document is created for each IMG document produced in Paint. 

An output list can be used to print or display documents immediately, and can 
also be saved and recalled at a later date for editing and use. A new output list 
is saved using the Save As... command in the File menu, supplying a name 
up to eight characters long and with the suffix .LIS. A previously saved list can 
be saved again under the same name with the Save command in the File 
menu. 

A previously saved output list can be recalled using the Open .. . command in 

the File menu. 

6.5 Output Options 

The Options menu offers commands to control the way in which documents are 

presented. For example, the position of a picture on the paper can be controlled, 
or the speed at which images are sent to the screen. 

When the documents in the output list are sent to an output device, the 

currently set options are used. If you have not set any options, the default 
options are used. (The default options are those automatically set when GEM is 

started.) The same options are used for all the documents in the output list. To 
set different options for each document, it is necessary to create a separate 

output list for each. 

A series of options can be saved using the Save Options . . . command in the 
File menu. The options are saved in a document with the suffix .OPT. A 

previously saved set of options can be recalled with the Get Options... 

command in the File menu. 
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The default options can be altered to a set of specially selected options. To make 
a set of options the default, use the Make Default command in the Options 
menu. These options will then be used automatically every time GEM is 
started, although it remains possible to select different options or saved sets of 
options within each session. 

Documents with the suffix .OPT are stored in the GEMSYS folder. To delete 
option documents you no longer require, open the GEMSYS folder from the 

Desktop and delete the unwanted documents. If you have changed the default 
options, and want to restore the original defaults, open the GEMSYS folder 

from the Desktop and delete the DEFAULT.OPT document. The original 

defaults will be restored. 

6.6 Menu Commands 

6.6.1 File 

The File menu offers the following commands: 

New 

Open... 
Close 
Save 
Save As... 
Get Options... 

Save Options... 

Start Output... 

Quit 

New -— begins a new output list. If the currently displayed list is new or has 

been edited and not saved, a warning message is issued, as beginning a new list 

would delete the present one. 

Open... — opens a previously saved output list. The item selector appears; 

click on the required document name. Use the slider and scroll bars if necessary 
to move through the directory, or click on the close box of the item selector and 

open other folders to select a document in another directory. Alternatively, 
type the directory path of the document, and either click on the document name 

or type it on the selection line. The directory displayed when the item selector 
first appears will be that open in the application used before entering Output, 
or that displayed on the Desktop. If a new or edited output list is already open, 
a warning message is issued before the item selector appears, as opening 
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another list would delete the present one. The document selected must have the 

suffix .LIS, 

Close — closes the list currently on the screen and does not display another 
list. A warning message is issued if the current list is new or has been edited 
since it was last saved. 

Save — saves the currently displayed output list under the same name. This 

command is not available if no list or a new list is displayed. 

Save As... — saves the currently displayed list under a name supplied to the 
item selector. The name may have up to eight characters, and must have the 
suffix .LIS — if a name without a suffix or with a different suffix is supplied, a 
warning is issued. 

Get Options 

selector appea: 

— retrieves a previously saved set of options. The item 

he document selected must have the suffix .OPT. 

  

Save Options ... — saves the current options under a name supplied to the 

item selector. The name may have up to eight characters and must have the 

suffix OPT — if a name without a suffix or with a different suffix is supplied, a 
warning is issued. 

Start Output... — allows documents to be sent to the printer, plotter or 
screen. The following dialogue appears: 

START OUTPUT 

Device: Screen Printer Plotter Camera 
Number of copies: 01[ 

OK Cancel 

The camera is not currently available as an output device. 

‘The highlighted device is that currently selected. If necessary, use the [beveTe] 
key to delete the number in the Number of copies line and type in the 

required number. Output will begin as soon as you click on OK or press the 

key. All items in the output list will be printed or displayed, using the 
currently selected options. If items are sent to the printer, a dialogue reports 

the progress of printing, counting down the documents and copies printed. 

Press the key to abandon output at the end of the current page. 

Quit — leaves the Output System and returns to the application from which 
the Output System was accessed, or to the Desktop. 
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6.6.2. Edit 

The Edit menu offers the following commands: 

Add Name... 
Duplicate Name 

Delete Name 

Duplicate Name and Delete Name require that an item on the list is selected; 

if none is selected, these commands are not available. To select a name, click on 
it once. To select several names, drag from the first to the last name. Selected 
names are highlighted. 

Add Name... — adds a name to the output list. The item selector is 

displayed. If there are no other documents in the list, a document may be 

selected from another directory by using the close box and opening other 

folders, or by deleting the current directory path and typing the directory path 

of the required document. If there are already other entries in the list, however, 

the next document must be selected from the same directory. If it is not, a 

message will be issued, and the document will not be added to the list. Only 

documents with the suffix .GEM, .IMG or .DOC may be added. 

Duplicate Name - duplicates the selected name in the list. The document 
will then be printed or displayed twice. 

Delete Name - removes the selected name(s) from the list. 

6.6.3 Options 

The Options menu offers the following commands: 

Screen... 
Printer . 
Plotter... 
Camera Film... 
Camera Color... 
Make Default 

    

The camera is not currently available as an output device. 

Screen... — allows options to be set controlling the display of documents 
output to the screen. The following dialogue is displayed. 

SCREEN OPTIONS 

Seconds 

Wait for: Key 2 5 10 20 
Cycle: No Yes 

OK Cancel



The Wait for option allows you to choose the time delay between documents 
sent to the screen. This may be a number of seconds (2, 5, 10, 20) or until a key 
is pressed (Key). Any key can be used, except [f_], which displays the 
previous picture, and which aborts the output sequence. Press the 

key at any time to interrupt output to the screen. 

Printer ... — allows options to be set controlling the presentation of printed 
documents. The following dialogue is displayed: 

PRINTER OPTIONS 

Scale: FullScale Best Fit 

  

Initial Form Feed: Yes No 
Final Form Feed: Yes No 

Horizontal Justification: Left Center Right 

Vertical Justification: Top Center Bottom 

Print in Background: Yes No 

OK Cancel 

Full Scale prints the picture or text at full size, taking several sheets of paper 
if necessary. (This option can ony be used with continuous form feed paper if 
documents cover more than one sheet.) 

Best Fit reduces the size of the picture to fit it onto a single sheet of paper. 

The Initial Form Feed setting controls whether the printer advances by one 
sheet of paper before beginning to print each document. 

The Final Form Feed setting controls whether the printer advances by one 
sheet of paper after printing each document. 

The Horizontal Justification setting controls the horizontal alignment of 

the document on the paper. 

The Vertical Justification setting controls the vertical alignment of the 
document on the paper. 

The Print in Background setting controls whether the GEM applications and 
Desktop are available for use while the printer operates. Background printing 
requires 320 Kilobytes of Random Access Memory (320K RAM); check the 
capacity of the system before selecting this option. 

Make Default — sets the present selection of options as the default. To restore 
the original default options after replacing them, open the folder GEMSYS 
from the Desktop and delete the icon for the document DEFAULT.OPT. 
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6.6.4 OUTPUT 

The OUTPUT menu offers the following commands: 

Output Info... 
Snapshot 

Calculator 
Clock 
Print Spooler 

Output Info... — displays copyright and other information about the Output 

System; not all of this applies to the Acorn version of GEM. 

Snapshot - takes a snapshot of part of the screen and saves it, giving it the 
document type .IMG. Details of how to use the Snapshot facility are given in 
Paint, 3.6.7. 

Calculator — superimposes the calculator over the window. Instructions on 

using the calculator are given in 2.13.1. 

Clock — superimposes the clock over the window. Instructions on setting the 
clock are given in 2.13.2. 

Print Spooler — displays the print spooler list, allowing document names to 
be added to or deleted from the list for immediate printing. To add a name, click 

on the Add box and the item selector appears; select a document to be added (it 

must be a text document with the suffix .DOC). To delete a name, click on the 
name and then on the Delete box. Click on its close box to remove the spooler 

list. Items added to the print spooler list are printed immediately in draft form 

(i.e. without special text attributes). Printing is interrupted while the item 
selector is displayed, but recommences as soon as it is removed from the screen. 

The Desktop and applications can be used while printing continues. 

Note: All of the accessories may not be available (see 2.13). 
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7 APPENDIX: SET-UP 
GUIDE 
  

7.1 Introduction 

The following items make up the GEM package; check that you have all these: 

Hardware — co-processor 
mouse 

Software ~ three discs holding the GEM software. 

If any of these is missing, return to your dealer. 

  

‘The order in which the installation is carried out is: 

attach the mouse 
fit the co-processor 

configure the system 
copy the dises. 

If you have any problems with the installation, or if you feel uncertain about 

whether you can carry out the installation yourself, take the package and 

microcomputer to your dealer and ask him/her to instal the package for you. 

The dealer may charge for the installation. 

7.2 Attaching the Mouse 

‘The mouse is attached by fitting its plug into the socket marked User Port on 

the underside of the microcomputer, near the front. The plug will only fit into 

the socket one way, so it is not possible to fit it incorrectly. Align the projection 
on the plug with the notch in the socket and press the plug in firmly. Two 
securing arms will move into place when the plug is correctly positioned. 
Ensure that these click across the back of the plug. 
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7.3 Fitting the Co-processor 

7.3.1 Notes 

Any modification or upgrade carried out to the printed circuit board of any 

Acorn equipment is undertaken at the sole risk of the person carrying out the 
modification or upgrade. No claim for loss or damage to the equipment caused 
by the modification or upgrade of the printed circuit board by unqualified 
personnel shall be accepted by Acorn Computers Ltd. 

Some of the components used in Acorn equipment are sensitive to static 
electricity. Take precautions to prevent static electricity damaging the 
equipment. 

Read all through the instructions before attempting the installation. 

7.3.2. The Co-processor 

The co-processor runs computer languages, applications and user programs. 

The microcomputer handles all input and output (e.g. input from the keyboard 

or discs, output to the screen, disc, printer, network, etc.). Communication 

between the co-processor and the microcomputer is by means of an interface 

known as the TUBE. 

The co-processor fitted to run GEM is an 80186 co-processor. 

7.3.3 Dismantling the Microcomputer 

Disconnect the microcomputer from the mains supply. 

The upper half of the case must be removed to allow access to the main printed 

circuit board. Turn the microcomputer upside down on a firm, flat surface. 
Locate the four fixing screws on the underside of the unit; there are two at the 

front and two at the rear of the case, and they are labelled FIX. These hold the 
upper part of the case in place. Remove all four screws; the two screws at the 
rear are longer than those at the front. Hold the two halves of the case together 
and carefully turn the computer back over so that it is the right way up. Lift 
away the top part of the case. This reveals the main printed circuit board where 
the co-processor is to be fitted. 

7.3.4 Installing the Co-processor 

The co-processor is a printed circuit board which is fitted above the main 

printed circuit board of the microcomputer and is supported by plastic support 
posts. Communication between the microcomputer and the co-processor is by 

means of the Tube, a series of pins which must be fitted exactly into the 

corresponding sockets on the computer's circuit board. 
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The support posts must first be inserted into the circuit board of the 

microcomputer. The illustration below shows the positions; the supports must 

be inserted in numerical order. There is no difference between the support 
posts, and both ends of the supports are identical. At each end of each support is 
a flange; this prevents the support being dislodged once it has been positioned, 

so it is important to align the support correctly before pushing it home. Place a 
support in the first hole and check that the flange does not obstruct or interfere 
with any component on the circuit board. When it is straight, press it down 
gently. 

When all the support posts have been pressed in, place the co-processor on the 
supports, aligning the holes in it with the support posts. Ensure that the pins of 

PLI on the co-processor are aligned with the corresponding holes in SK1 on the 

main circuit board, and that the pins of PL2 on the co-processor are aligned 

with the holes in SK2 on the main circuit board. When all the pins and support 

posts are correctly positioned, gently press the co-processor into place. Do not 
put too much pressure on the co-processor as this may damage it. The barbs on 
the ends of the supports should clear the co-processor board, and will make an 
audible click when they spring into place. 

To re-assemble the microcomputer, replace the upper part of the case, hold the 
two parts together while carefully inverting the unit, and replace the four 
fixing screws. Use the longer screws in the two holes at the rear of the case, 

MAIN PC.B. OUTLINE (185.1) 

  

    
  

      

  CO-PROCESSOR PCB(OVER) 
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7.4 Configuration 

Set up the microcomputer following the instructions in the Welcome Guide and 

turn it on, A message similar to the following should appear: 

ACORN MOS 

ACORN ADFS 

BASIC 

m 

Although the co-processor has been fitted correctly, the microcomputer does 
not yet recognise it. It is necessary to CONFIGURE the system to include the 
co-processor. Configuration may be performed either by using the control panel 
included with the Welcome package or using the *CONFIGURE command. To 
use the *CONFIGURE command, type 

*CONFIGURE TUBE [RETURN] 

*CONFIGURE INTUBE [ReTuRN] 

and then press the and [sreax] keys simultaneously. A message similar 
to the following should then appear: 

ACORN TUBE 80186 512K 

ACORN ADFS 

BASIC 

The top line of the display acknowledges the presence of the tube, which is now 

recognised. The first disc drive will begin to operate as the microcomputer waits 

for an operating system to be loaded. This will be done next. 

If the message displayed does not acknowledge the presence of the co-processor, 
use the *STATUS command to determine whether the Tube has been correctly 
configured. If it has, check that it has been fitted correctly. If no obvious 

mistakes have been made, take the microcomputer to a registered Acorn dealer 
for testing. 
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7.5 Copying the Software 

It is VERY IMPORTANT that you copy the GEM discs before using them to 
run GEM. If you always use copies, you can make another copy in the event of 
losing or destroying your working copy, or inadvertantly deleting any of the 
data needed to run GEM. Ensure that the master copies are write-protected so 
that the data cannot be corrupted or deleted. 

The procedure for copying the software is not the same with a system using 

floppy discs as with a system using a hard disc. Follow the instructions in 7.5.1 
and 7.5.2 for a floppy disc system, or those in 7.5.3 for a hard dise system. 

7.5.1 Formatting the Dises - FLOPPY DISC SYSTEM 

Three discs are needed to hold the GEM software: 

the BOOT disc holds the data needed to load DOS, the operating system from 

which GEM is entered. 

the PROGRAM disc holds the GEM programs. 

the DATA disc stores data for documents you create or which are supplied. 

If necessary, configure the system to acknowledge the presence of the 

co-processor (this is described in 7.4), The top disc drive should be operating, 

and the red light should be illuminated. Insert the Boot disc into the drive and 
close the door. A message similar to 

Loading DOS.. 

indicates that the operating system is being loaded. When loading is complete, 

the prompt 

A> 

appears. Type 

bisk 
and insert a blank disc into the second disc drive. A list of options is displayed; 

one of these is Format Diskette, and is highlighted. Press the key to 
accept this selection. A list of format options appears; when copying discs, it is 
necessary to use the same format as that of the disc to be copied. In this case, 

the required format is 648 Kb [D0S] Bootable DOS Disk, which is already 

highlighted. Press the key to select this format. A message asking you 
to confirm the selection appears; press [RETuaN] again, and close the door of the 
second disc drive when the drive begins to operate. The progress of the 
formatting operation is reported as it proceeds. 
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When formatting is complete, a message asks whether the disc is to be made 
bootable. Yes is highlighted; press the key to make the disc bootable. At 
the end of the verifying procedure, the formatting options list reappears. 

Remove the disc in the second drive, insert another blank disc and use the 
arrow key or space bar to select the format 8@8Kb [DOS] Acorn DOS Format. 
Repeat the formatting; this time the verifying procedure will follow 

automatically with no message. After formatting the second disc, insert and 
format the third in the same way (i.e. 800Kb format). 

When the formatting options are displayed after formatting the third disc, use 

the arrow key or space bar to select the option Return to main menu and press 

[Return]. The first selection list is restored. 

Any additional data discs you want to create to hold GEM documents must also 

be formatted as 800Kb discs. 

7.5.2 Copying the Dises - FLOPPY DISC SYSTEM 

Leave the Boot disc in the first disc drive and insert the blank, newly formatted 

640Kb (Bootable DOS) disc into the second drive. Use the [_7_] key to select 

the option Copy Diskette and press [RetuaN]. The next selection offers 

Copy from drive A: — press [RetuRN] to accept this, and again to accept the 
next selection, Copy to drive B:. A warning message asks you to confirm the 

copy command; press again. The progress of the copying is reported as 
it proceeds. When copying is complete, remove the discs, and write a label and 

attach it to the copy. (Always write the label BEFORE attaching it to the disc, 

to avoid damaging the disc.) Put a blank 800Kb disc in the second drive, and 
the Program disc in the first drive. Repeat the copying procedure, and then 

copy the Data disc onto the other blank disc. Label each newly copied disc, and 

put a write-protect tag over the new Boot disc. 

7.5.3 Copying the Dises - HARD DISC SYSTEM 
Before configuring the system to recognise the Tube, ensure that the drive is 

correctly connected and that the disc is formatted. Consult the Winchester Disc 

Filing System User Guide for instructions if necessary. Configure the system 
and load DOS as described in Section 7.4. 

The first stage is to create a partition on the disc to hold the GEM software. 
Type the command 

uDIsk 
Several sizes of partition will be offered. It is not necessary to allocate all the 
available space to DOS, and it is possible to alter the size of the partition later 

(although this will involve deletion of all the data stored). A partition of ten 
megabytes is a suitable size. If a message reports that the disc is full, select a 
smaller size. If a message reports that compaction is necessary, consult the 
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Winchester Disc Filing System User Guide for instructions on compacting the 

disc. 

Select a size and press the [Return] key. Press it again to confirm the choice. 
Progress is reported as the disc is processed. 

The list of selections returns to the screen. Use the arrow keys to select 

Make Bootable, press the [Return] key, and press it again to confirm the 

selection. Progress is reported. This copies the operating system from the floppy 

disc. 

It is now possible to load DOS from the hard disc; press the [erat ] and [ereak 
keys simultaneously. When prompted, press the [Retuan] key to load DOS. 

The next stage is to copy the GEM discs onto the hard disc. Type 

HDINSTAL [RETURN] 

The system prompts for the discs to be inserted in the correct order — follow the 
instructions to copy the discs. 

  

The system is now ready for loading GEM. Turn to Section 2 of this manual for 
instructions. If you want to turn off the co-processor instead, ensure that the 

Boot disc is in the first drive and then type 

NOTUBE [reTuRN] 

This re-configures the system to bypass the Tube. 

7.6 Four Colour GEM 

There is a screen driver on disc 4 which enables GEM to be run in four colour 
mode, this screen driver can be installed using GEM Setup as explained in the 

next section. 

There are two points to note about the four colour screen driver: 

— The horizontal resolution of the screen in pixels is only half the horizontal 

resolution of the screen when running in two colour mode, although the 

display width is still eighty characters. This results in some loss of legibility 
with text. 

— The four colour drivers take up more memory than the two colour drivers. 

Some applications may not run as a result of this. In some cases this can be 
solved by deleting the GEM Desktop accessories. This must be done before 
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starting up GEM Desktop; insert your working copy of disc 2 (not the master 
copy) into your logged on disc drive and type: 

DEL \GEMBOOT\*.ACC 

7.7 GEM Setup 

The GEM software must know the details of certain aspects of your computer 
system, these are: 

— Whether you are running GEM in 2 colour or 4 colour mode. 

— Whether your printer is connected to the serial or parallel port. 

— The type fonts that are to appear in screen output or on the printer. 

You must run GEM Setup if you want to change any of the above. 

The following two sections on starting and using GEM Setup assume that you 
are familiar with using the GEM Desktop. If this is not the case then you 
should study the appropriate chapters of this user guide before proceeding. 

CAUTION: Never use GEM Setup to modify the master copy of disc 2, only use 
it on your backup copies. 

7.7.1 Starting GEM Setup 

— Start up GEM Desktop as explained in this user guide. 

— Insert disc 4 (labelled Miscellaneous) into floppy disc drive B. 

— Open the drive B icon. 

— Open the icon labelled GEMSETUP.APP. 

7.7.2 Using GEM Setup 

The categories menu allows you to select the part of your setup which you want. 

to change (i.e. Graphics card, Printer or Plotter). Note that Cameras, Tablets 
and Miscellaneous are not currently supported. (Contact your Acorn dealer 
for advice if necessary.) 

Note: You must work through all the options on the menu configuring each 
displayed item. 

— Select the Graphics Card option from the categories menu.



— Drag one of the available graphics cards from the lower window to the upper 
window (labelled Chosen Graphics Card). 

— Select Screen Fonts from the categories menu. 

— Drag at least one of the available screen fonts from the lower to the upper 
window. 

— Select Mouse from the categories menu. 

- Drag Acorn Mouse from the lower to the upper window. 

— Select Mouse Port from the categories menu. 

— Drag User Port from the lower to the upper window. 

— Select the Printer option from the categories menu. 

— Drag one of the available printers from the lower window to the upper 
window (labelled Chosen Printer). 

— Select Printer Fonts from the categories menu. 

— Drag at least one of the available printer fonts from the lower to the upper 
window. 

The file menu contains five options: 

- The Open summary option displays the current setup. When the summary 
window is on screen, this option changes to Close summary. 

— The Show info option gives more details about a selected item in the 
available window. 

- The Clear choice option removes all items from the chosen window. 

— The Save summary option must be used before leaving GEM Setup to save 
your new setup. 

— The Quit option returns to GEM Desktop. You will be warned if you attempt 
to quit without first saving your new setup. 

After you have created your new setup you should save it using the Save 
summary option from the File menu, and then exit from GEM Setup. Your 
new setup will not take effect until you restart GEM by exiting back to the DOS 
Plus and typing GEM again. 

The most likely cause of failure is when something has been partially installed 
(e.g. installing the four colour screen driver without re-installing the mouse). 
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8 GLOSSARY 
  

accessory 

See desk accessory. 

active window 

The window on which you can work; it is always displayed over any other 

windows. It may be a picture in Paint superimposed over another picture or any 

of the special windows produced by some commands — for example, the clock or 

item selector. 

application 

A computer program which perfoms a function for the user. Drawing, 
word-processing and accounts programs are examples of applications. The 
applications in the GEM package are Paint, Write and Desktop. 

boot dise 

Disc containing the data required to BOOT UP or prepare the computer. The 
DOS Plus boot disc used with GEM prepares the computer for the GEM 
package by loading the DOS Operating System. 

click 

To press and immediately release the lefthand or centre mouse button. 

close 

To close a window, folder or directory. Closing a window removes it from the 

screen. Closing a folder or directory moves up one level through the directory 

path. 

close box 

‘The butterfly symbol in the upper lefthand corner of a window. Clicking on this 
closes the window, or closes the directory if the window is the item selector. 

command 

Word or phrase in a drop-down menu which causes the program to take some 
action.



communication port 

An outlet on the computer to which a hardware device can be connected. 

cursor 

Horizontal bar showing the position at which text will be added in a Write 

document. When Insert Mode is set ON, the cursor changes shape, appearing 

as a vertical line. 

de-select 

‘To remove the highlighting which indicates that an icon or text is selected and 

return it to its usual state. 

desk accessory 

A device accessed from the Desktop, Write, Output or Paint menu. An 

accessory performs a function which is independent of the main application in 

use. The accessories supplied are a clock, a calculator, a camera (snapshot) and 
a print spooler. Additional accessories may be added. 

dialogue 

A message or question(s) issued by GEM in response to a command. 

directory 

A collection of folders and/or documents stored in a single place and listed 
together by the item selector or displayed together in a Desktop window. For 
example, the contents of the GEMAPPS folder displayed on the Desktop 
comprise a directory. 

directory path 

The sequence of folders which must be opened to find a document or folder. 

directory path name 

Formal representation of the sequence of folders which must be opened to find a 
document or folder. The directory path name begins with a letter identifying 

the disc drive; folders are listed with the highest level first, each folder name 

being followed by a backslash (\); the document name apppears at the end, 
with its suffix. The directory pathname of the document in use is reported in 
the title bar of the active window. 

document 

A picture or text file produced with Write or Paint. It has a suffix indicating its 

type (e.g. .DOC for a text document). 
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double-click 

To press and release the lefthand mouse button twice in rapid succession. 

drag 

To hold down the lefthand mouse button, move the cursor across the screen by 
moving the mouse, and release the button. 

drop-down menu 

List of commands which are displayed (‘drop down’) when the pointer moves 
over the name of the menu in the menu bar. 

embedded command 

Line in a Write document beginning with two full stops (..) which gives an 
instruction controlling the presentation of the printed document. The command 
is not printed literally in the document, but may force a page break, define 
headers or footers, record an unprinting comment, mark the place of an 
inserted Paint document or alter the current page number. 

folder 

Item in which documents or other folders are stored. It is analogous to a real 

folder. 

font 

Set of letters, numbers, punctuation marks and symbols of a consistent design. 

footer 

Line of text printed at the foot of each page of a text document. 

format (disc) 

To prepare a disc to receive data. A new disc must be formatted before it can be 
used. Discs used with GEM should be formatted as 640Kb (for the Boot disc) or 
800Kb (for the Program and Data discs, and for any additional discs for storing 
created documents). 

format (text) 

To reposition text after editing so that it is aligned between the margins and is 

continuous within each paragraph. 

full size box 

Diamond shaped box in the upper righthand corner of a window; clicking on the 
full size box returns the window to its full size, or reduces it to its last size if it is 
already full size. 
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header 

Line of text printed at the top of each page of a text document. 

icon 

Pictorial representation of a disc, application, folder or document. Any 
operation performed on an icon causes the computer to take the equivalent 
action with the corresponding data, etc. For example, deleting a document icon 

causes the data stored under the name of that document to be erased from the 
disc. 

item 

Application, folder or document in a directory. 

item selector 

Window displayed when a choice of document or a name for a new document is 

required, The item selector lists the documents in the current directory; the 

directory path name is shown in the top line of the window. To select an item, 

click on it or type its name in the selection line, and press the [ReTuRN] key or 

click on OK. If the required item is not in the current directory, move through 

the directory path by clicking on the close box and opening other folders by 

clicking on them. Folders are identified by diamond shapes to the left of their 

names. 

memory 

Temporary data store within the computer. Data stored only in the computer's 

memory will be lost on leaving the system or turning off the computer. As a 

safety precaution, always save your documents at frequent intervals during 

editing. 

menu 

List of commands or other options; click on the line offering the required 
function to select it. 

menu bar 

The bar along the top of the screen containing the names of the menus. Moving 

the pointer onto a name in the menu bar causes that menu to drop down. 

mouse 

Box with buttons; moving the mouse causes a corresponding movement of the 

pointer across the screen. Items and menu commands are selected by pressing 
the lefthand button when the pointer is over the required line or icon. 
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open 

Display the contents of a disc directory, application, folder or document. 
Opening a document makes it available for editing. Opening a folder causes the 
contents of the folder to be displayed, either in a new Desktop window, or in the 

item selector if the folder is selected from this. Opening an application (the 

Paint or Write icon) starts the appropriate program and displays the screen 
with a new, empty document. Opening a disc icon displays the contents of the 

disc in a new Desktop window. An icon can be opened by double-clicking, or by 

clicking and then choosing the Open command from the File menu. In Paint or 
Write, a document is opened by selecting the Open... . command from the File 

menu and supplying the document name to the item selector. 

operating system 

A large collection of programs which governs the internal management of the 
computer. The operating system coordinates the hardware and software, 
retrieves and interprets data input from the keyboard or dise drive and 
performs all types of controlling operations. 

pointer 

Indicator of position on the screen, usually in the form of an arrow. It moves 
corresponding to the movement of the mouse. The pointer changes shape 

during some operations. 

save 

Transfer information from the computer's memory to disc for permanent 
storage. It is advisable to save documents frequently to prevent substantial loss 
of data in the event of a power or computer failure, or accidental deletion of the 
document from the computer's memory. 

scroll bar 

Shaded area in the right or lower margin (or both) of many windows. Clicking 

on the shaded area causes a different part of the window to be displayed. The 
position of the slider indicates which part of the window is currently visible; 

click on the scroll bar to the right of the horizontal slider to display an area of 
window to the right of that displayed, click on the scroll bar below the vertical 
slider to display a lower part of the window, and so on. If no scroll bars are 

present, the entire window is visible. If one scroll bar is missing, the part 

currently visible extends to the limit of the window in that direction. For 

example, if there is no scroll bar above the vertical slider in a Write window, the 
beginning of the document is on screen. 
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select 

To choose a menu item, icon or Paint symbol by clicking on it. Selecting a menu 

item causes a command to be executed; selecting an icon designates that icon as 

the one which will be affected by the next action or command; selecting a Paint 
symbol makes that the current tool, colour or pattern. 

shift-click 

Press and immediately release the lefthand button on the mouse whilst holding 

down either the [suit] key on the keyboard or the righthand button on the 
mouse. Shift-clicking is used to select several items at once on the Desktop. 

size box 

Symbol in the lower righthand corner of many windows; drag the size box to 
modify the size of the window. 

slider 

Clear rectangle within the scroll bar. The size and position of the slider 

corresponds to the area of the window currently visible on the screen. 

title bar 

Bar across the top of a window reporting the name of the document or directory 

displayed in the window. When two windows are visible, the title bar of the 
active window is highlighted. 

unavailable command 

Menu command which is not currently available; unavailable commands 

appear in faint type. 

window 

Rectangular area displaying a document, directory, desk accessory or item 

selector. Only part of the document or directory may be present, in which case 
scroll bars and sliders indicate the area which is visible. Many windows have a 
title bar, menu bar, and size, full size and close boxes. More than one window 

may be present on the screen at once, but only one can be used (the active 
window).



9 GEM INDEX 
  

In the following index, only the more informative references are listed. 

The abbreviations D, O, P and W are used to indicate reference to 
Desktop, Output, Paint and Write commands. 

Abandon command 26(P),41(W) 
Abandon edited image? dialogue 

25,26 
accessory 15 

calculator 16 
clock 16 
print spooler 49,61,69 
snapshot 31 

active window 33,77 
Add Name ...command 67 
Add name to spooler list 49,61,69 

adding disk icons 56,58-9 

adding folders 54 
adding names to output list 67 

airbrush 22 
Appendix 70-6 
application 11,59,77 

icons 11,59 
installing 59 

removing 59 

saving installation 59 
starting 11 

types 59 

Application type: option 59 

Arrange menu 60-1 

arrow keys 
moving item selector cursor 40 

moving text cursor (W) 37 

arrows (scroll bars) 10,14,32 
ASCII text files 51 
attaching the mouse 70 

auto-reformat 45,47 
available commands 25 

background printing 68 
* BAK files 48 
BBC 
returning to 12,58,76 

Best Fit option 68 

‘blinking’ rectangle 24 
Bold command 30(P),44(W) 
Boot disc 74-6,77 

brush shape 22,27 
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unavailable 11,25,39,57,82 
«+Scomment> 49 
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initial appearance 6 

saving 60 

starting 4-5 

desktop accessory 15-6,78 

Desktop icons — see icon 

Desktop Info ... command 61 
DESKTOP menu 61 
dialogue 12-3,78 

entering/editing text 13 

messages 13 

diamond symbol 36 

directory 8,52,78 

closing 9,14 

method of display 60 
root 53 
scrolling 14 

sorting 60-1 

directory path 8,52-4,78 

moving through 14 

directory path name 52-3,78 

disc drive 
identifier 59



installation 58-9 
removal 58-9 

disc icon 
adding 56,58-9 
opening 11 

removing 58-9 

discs 70 
copying 75-6 

formatting 74,75-6 

DISK command 74-5 
dismantling the computer 72 

displaying menus 11 
-DOC document type 34,40,41, 

49,64,67,69 
document 7,78 

Document Disk: option 48 

document icons 10,17,34,59 
Document mode: option 46 

DOS 4-5,58,59 

loading 5,76 

prompt 5,74 
returning to 12,58 

DOS-takes-parameters 59 
double-click 7-8,79 

speed 59-60 
to start applications 11 

down-arrow key 

moving text cursor 37 

drag 7,79 

Drive Identifier: option 59 
drop-down menu 11,79 
Duplicate Name command 67 

duplicating names in output list 
67 

Edit menu 42(W),67(0) 
Edit Pattern ...command 29 
editable text field 12,14 
embedded commands 49-50,79 
END key 38 

Enter DOS Commands... 
command 60 

entering text in dialogues 12-3 

Epson FX-80 62 

eraser 22 

[escaPe] key 
cancelling last operation (P) 27 

editing text fields 14 
interrupting output 66 

Exit to DOS command 12,58 

Filemenu 25-6(P),40-1(W), 

57-8(D),65-6(0) 
filing structure 52-4 

Final Form Feed: option 68 

Find ...command 43 
Find Next command 44 

Flip Horizontal command 28 

Flip Vertical command 29 

floppy disk 
copying 75 
formatting 74-5 
installing 58-9,75 

removing 58-9 

folder 7-8,52-6,79 

folder name 54 

folders 

copying 55-6 

creating 54 

opening 11,14 

Font menu 44 

fonts (P) 79 
--FOOT 49-50 

footers 47,49-50,79 

Format . ..command 
46-7(W),50,58(D) 

format text 79 
auto-reformat 45,47 
manual reformatting 45 

formatting discs 79 

floppy discs 74-5 

hard dise 75-6 
Full Scale option 68 
full size box 9,19,32,36,79 

GEM applications 1,11,17,34, 
59 

GEM Desktop 52-61 

GEM Index 3



GEM Faint 11-33 
GEM Write 34-51 
GEM Write Info ...command 48 
-GEM (document type) 64,67 
~-GEM 50 

GEMAPPS folder 9,11 
GEMSYS folder 65,68 
geometric shapes 21-2 
Get Options ...command 64,66 
GoTo...command 44 
Grid On/Off command 27 

hard dise 
copying GEM to 76 
formatting 75-6 
installing 58-9,75 
removing 58-9 

hardware 70 
HDINSTAL 76 

HDISK 75-6 
-sHEAD 49-50 

headers 46-7,49-50,80 
Hide/Show Patterns command 28 
HOME key 38 
Horizontal Justification: option 

68 

L-beam 42 ’ 
icon 3,10,80 

copying 54-6 

deleting 58 
de-selecting 10 
label 59 
opening 10 

renaming 57-8,58-9 

selecting 10 

type 59 

-IMG (document type) 17,31,40, 

64,67 
Info/Rename ...command 57-8 
Initial Form Feed: option 68 

insert cursor 42 
Insert Graphics ...command 40-1 
Insert Line command 42 

GEM Index 4 

insert mode 45 
Insert Text ...command 40 
Install Disk Drive .. .command 

58-9 
installing applications 59 
installing disk drives 58-9 
Italic command 31(P),44(W) 
item selector 13-4,54,80 

altering directory path 14 

changing to another directory 14 

justification 31,46,68 

horizontal (O) 68 
left (P) 31 

right (P) 31 
vertical (O) 68 
Justification mode: option 46 

Key option 67-8 

keyboard equivalents 27,39-44,57-60 

Left Justify command 31(P) 
Left margin: option 47 

Line spacing: option 46 

line width 21 
setting 20 

-LIS (document type) 64,66 

Load Patterns ...command 29 
loading GEM 4-5 

Make Default command 65,68 

Make Pattern command 28-9 
manual reformatting 45 

margins 45,46 

memory requirements 68 

menu 3,11,80 

displaying 11 

keyboard symbols 39,57 

removing 11 

selecting commands 11 

menubar 9,80 
microscope 23 

MONO.PAT 29



mouse 6,80 

buttons 7 
installing 70 
moving 6 

Move command 42 
move 

cursor 37-8 
graphics 24 

text 42 

windows 32 
moving through directory path 14 

multiple windows 33 

NAME CONFLICT DURING COPY 

dialogue 

resolving 56 

Newcommand 25(P),40(W),65(O) 
New Folder icon 54 
NONE pattern 19,21-2 

Normal command 30(P),44(W) 

NOTUBE 12,58,76 
Number of copies: option 66 

numeric keypad 

releasing functions 37 

OK 12-4 

open 10,11,81 
application 11 

document 25(P),40(W),64, 
65-6(0) 

folder 11 
output list 64,65-6 

Open command 12,57(D) 

Open ...command 25,33(P), 
40(W),64,65-6(0) 

operating system 81 

-OPT (document type) 64,66 

options 

printer 68 

screen 67-8 
Options menu 47-8(W),58-60(D), 

67-8(0) 
-OUT (document type) 41,48 

*OUT files 48 

output. 

changing options 67-8 

device options 67-8 

document types 64 

entering 63 

options 64-5 

printer options 68 

saving options 66 
screen 63 
screen options 67-8 

starting 66 

stopping 66 

Output Guide 62-9 

Output Info ...command 69 

output list 64 

adding names 67 

character limit 64 
closing 65 

creating 65 

deleting names 67 

document types suitable 64 
duplicating names 67 

opening 65 

saving 66 

selecting names 67 

OUTPUT menu 69 
output options 64-5,66,67-8 

deleting sets 65 

loading 66 

printer 68 

saving 66 

screen 67-8 
setting 67-8 

«=PAGE 49 

page break 49 

Page Length: option 46 

Page menu 44-7 

page numbers 50 

Pagination: option 46 

Paint 17-33 
screen 18 

starting 17 

PAINT.APP 17 

GEM Index 5



Paint Info ...command 31 
paintbrush 

selecting size 22,27 

painting size 27-8,32 

painting surface 18 

palette 

colour 18 
pattern 18 

tools 18,21-4 

-PAT document type 29 

patterns 19,21 

editing 29 

hide/show patterns 28 
Joading 29 

making 28-9 

NONE 19,21-2 

palette 18 

saving 29 

selecting 19 

Patterns menu 28 
pencil 22 

++PGNO 50 

pixel 23 
pointer 81 

polygon tool 21 
preferences 

setting 59-60 

Print Draft command 41 
Print in Background: option 68 

Print Spooler command 49(W), 

61(D),69(0) 

printer 

connecting 62 

options 68 

Printer ...command 68 
PRINTER OPTIONS dialogue 68 

quadrant tool 21 
Quit command 26(P),41(W),66(O) 

rectangle tool 21 

reformatting 

auto- 45,47 

manual 45 

GEM Index 6 

removing applications 59 
removing disc icons 58-9 
rename folder 57-8 
repeating output 66 

Replace ...command 43 
Replace Next command 44 

restoring default options 65 
[Retuan] key 12-4,23 

returning to BBC Master Series 

12,58,76 
returning to DOS 12,58 

Right Justify command 31(P) 

root directory 53 

rounded rectangle tool 21 
ruler 45-6 

save 81 

Save command 26(P),41(W),66(O) 
Save As...command 26(P),41(W), 

64,66(0) 
Save Desktop command 60 
Save Options ...command 64,66(0) 

Save Patterns ...command 29 
saving application installation 

59 

saving Desktop 60 

saving display of directory 60 

sorting of directory 60 

saving output device options 64 

saving output list 64,66 
Scale: option 68 

SCREEN OPTIONS dialogue 67-8 

screen output 67-8 

repeating 67-8 

time interval 67-8 
Screen... command 67-8 
scroll bar 9,14,32,81 
Search menu 43-4 
select 3,10,82 

application 10 

colour 20 
document 13-4 
folder 10 
graphics 24,28



line width 20 
menucommand 11 
pattern 19 
text 38-9 
tool 20 

Selection menu 28 
selector 24 

Set Preferences . 
47-8(W),59-60(D 

Set Tabs & Margins... 
command 46 

Set-up Guide 70-6 
setting date/time 16 

setting default options 65,68 

setting line width 20 
setting preferences 47-8(W), 

59-60(D) 
shift-click 7,82 

[suet] key 7,37 
Short Cuts ...command 47 
Show as Icons/Text command 60 
Show/Hide Ruler command 45-6 
size box 19,32,36,82 
Size Picture ... command 27-8 

slider 82 
Snapshot command 31 
software 70 
Sort by Date command 61 

Sort by Name command 60 
Sort by Size command 61 

Sort by Type command 61 
sorting directories 60-1 

Spill-file Disk: option 48 

START OUTPUT dialogue 63,66 

Start Output...command 66 
starting applications 11 
starting desk accessories 15 
startingGEM 4-5 
starting output 66 

*STATUS 73 

status bar 36 
stopping output 66 

straight line tool 22 

string 43 

+ command 

    

key 45 
Tabs 45 

setting 46 

tap 22 
Text begins on: option 46-7 

text cursor 36,78 
text directories 60 
text documents 

output to print spooler 49(W), 
61(D),69(0) 
output to printer 68 

output to screen 67-8 
Text ends on: option 47 

text field 12 
text tool 22-3 

time mode (clock) 16 
time setting 16 

title bar 9,15,32,33,35,82 

To Output ...command 26(P), 

41(W),58(D) 

Tools menu 27 
tools palette 18,21-4 

Transparent On/Off command 27 
Tube 4-5,71 
Turn Auto-Reformat On/Off 45,47 
Turn Graphics On/Off 41,45,47 

Turn Insert Mode On/Off 45 
tutorials 34,36-7 
Typeface menu 30 

Typestyle menu 30-1 

unavailable command 11,25,39, 

57,82 
Underline command 31 (P),44(W) 

Undo command 27 
up-arrow key 

moving text cursor 37 

screen output 68 

Vertical Justification: option 68 

View Picture ...command 27 
Volkswriter 34,51 

GEM Index 7



Wait for: option 67-8 
window 9-10,82 

additional 33 
arrows 10,14,32 
close box 9,15,19,77 

closing 9,15,19 
full size box 9,19,32,36,79 
moving 15,32 

scroll bar 9,14,32,81 
size box 19,32,36,82 

slider 9,14,¢ 

status bar 36 
title bar 9,15,32,33,35,82 

word processing programs 34,51 

WordStar 34,51 
Write 34-51 

screen 35-6 

starting 34-5 

tutorials 36-7 
Write Info ...command 48 
WRITE menu 48-9 
WRITE.APP 34 

  

GEM Index 8



Part 2 

DOS+ 
 



CONVENTIONS USED IN THIS 
MANUAL 

*CONFIGURE 

<number> 

Open 

[return] 

fa 

User Guide 

Text to be typed in literally, or text displayed on the screen. 

An item of data of the type indicated must be supplied, or is 
displayed on the screen. For example, a line described as Page 
<number> would appear with a number in place of <number>. 

Option in a menu line or dialogue which can be selected with the 
mouse. 

Press the key named. 

Press a numeric keypad key. This MUST be used where shown; 
where numbers are shown otherwise, either set of numeric keys 

may be used. 

Press the red function key indicated. 

The title of a manual.



PREFACE 
  

DOS Plus is a Dise Operating System whose function is to enable you to run 
your own applications and many commercial applications with maximum ease. 
It was developed by Digital Research to support both MSDOS applications and 
CP/M applications. This version of DOS Plus (1.2) has been specially adapted 
for the Master series and is compatible with DOS version 2 and with most 
features of DOS version 3. 

This manual is intended as an introduction to the many powerful features 
provided by DOS Plus for running your applications. It contains information on 

the common operations you will require and should be adequate for most of 
your requirements. If you want to go deeper into the full range of facilities 
offered by DOS Plus, see the Digital Research DOS Plus Users’ Guide, 2nd 
Edition, available from Digital Research. 

  

Chapter 1 is a brief outline of DOS Plus and its command format. Chapter 2 
contains details of how to load the DOS Plus operating system, and start using 
it. Chapters 3, 4 and 5 contain details of the commands and facilities you might 
use to handle your discs and files, and Chapter 6 contains information on how 

you might want to set up particular applications that you use frequently. 

Chapter 7 outlines some of the other facilities in DOS Plus, and Chapter 8 
introduces other commands and more complex use of commands already 

mentioned.
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1 INTRODUCING DOS 
PLUS 
  

1.1 Introduction 

This chapter explains briefly what an operating system is and what it does. It 
then introduces a specific operating system, DOS Plus, and describes some of 

its main features. Finally it shows the relationship between DOS Plus and the 

BBC Master. 

1.2 What an Operating System 
Does 

An operating system gives you control of the computer without having to learn 

complex sets of instructions. It enables you to manipulate files easily. It 

accepts characters from the keyboard and displays them on the screen. It 
controls the organisation and cataloguing of files on a disc and it gives you a 
flexible means of copying, rearranging or even erasing files. The operating 
system is a powerful tool that enables you to concentrate on the task you want 

to do, without worrying about how it is done or understanding the internal 
working of a computer. 

There are many different operating systems each with their own particular 

features and accepting a specific range of instructions. But they all give you 

more or less the same facilities and they're used in much the same way. You 

instruct the computer to perform a task by giving it a command or a series of 
commands. 

Some operating systems have become widely known and widely accepted 
because they are issued in different versions to suit a variety of computers. 

This is obviously a great advantage. It means that once you're familiar with a 
set of commands, you can use them on a number of different computers and 

achieve identical results. It also means that you-don’t have to worry about 

differences in hardware; the operating system will reliably and consistently 
interpret your commands and behave in a predictable manner.



Mowever wnat matters Lo most users 1s NOt tne operaung system so much as 
the quality and variety of the applications software available. That is, the 

software that performs specific tasks: word processing, stock control, account- 

ing and so on. The principle benefit of using a popular operating system is that 

a number of major software companies will have developed applications for it. 

This means that the applications are probably well designed, that you have a 

wide choice and that you can use the same application on a variety of computer 

systems. 

‘Two operating systems have achieved particularly wide acceptance. The first is 

CP/M, developed by Digital Research Inc. and the second is DOS (Disc 

Operating System) introduced by IBM for the IBM Personal Computer. 
Because these two operating systems were adopted by a number of computer 

manufacturers, a wide range of applications has been developed and marketed 

that will run under versions of CP/M or DOS. 

‘The availability of the applications led in turn to the development by Digital 
Research of a combined operating system, DOS Plus, that effectively offered 

the facilities of both DOS and CP/M. With one operating system, you can run 

either the applications that were originally developed to run under DOS or 

those that were developed to run under CP/M. 

1.3 DOS Plus and the BBC Master 

The DOS Plus operating system allows you to select from an increasing range 

of commercial software applications to run on your BBC Master. For instance 

you have access to a number of sophisticated DOS and CP/M based application 

programs that were originally written for the IBM and other personal 
computers. However, there can be compatibility problems and before buying a 
particular application you should check that it will function correctly on your 

BBC Master. 

When the BBC Master is running a DOS or CP/M based application parts of its 

own operating system are disabled and replaced by appropriate parts of CP/M 

or DOS. This means that the Master no longer responds to the BBC range of 

commands but it behaves instead as a CP/M or DOS based personal computer. 

However, the facilities of DOS Plus have been extended to allow you to take 

advantage of many of the Master's facilities. For example you can use the mode 

and colour facilities and these are covered in later chapters of this manual. 

The original CP/M and DOS operating systems have many features in common, 

and some fundamental differences. DOS Plus, by virtually combining the 
2



facilities of both, exploits the common features and enables you to ignore some 

of the fundamental differences. For example, CP/M and DOS store data in 
different formats — and one operating system will not normally read from or 
write to a disc formatted for the other. However, with DOS Plus you need not 
concern yourself about the different formats. The common features are 

described in the next section. 

1.4 Features of DOS Plus 

With DOS Plus the physical drivers are identified by the letters A and B (if two 

drives are present), If, in addition, you have a hard disc, this is identified as 

drive C. DOS Plus treats the whole of the disc surface as a single drive, so drive 
A reads and writes files on both sides of one disc and drive B reads and writes 
files on both sides of another disc. 

‘The DOS Plus prompt is normally 
A> 

which indicates that A is the currently selected drive. In common with most 
operating systems DOS Plus has a number of default settings. A default is a 

value or choice that will automatically be made unless you specify something 

different. Therefore, when you load DOS Plus it will automatically default to 

drive A, or drive C if you have a hard disc. Changing drives is covered in 

Chapter 2. 

Communication with DOS Plus is through a set of instructions called com- 
mands. These commands are really just a set of program names. You enter the 
name of the command and the appropriate parameters, and the program is 
executed. 

For example if you want to erase a file which you have called TEMP.TXT, you 
could issue the command 

A>ERASE TEMP. TXT 

where ERASE is one of the commands that you can use to delete a file. 

1.4.1 Filenames 

Generally speaking, filenames can be any combination of up to 8 letters and/or 

numbers. So you could have files called FRED, FRED1, ACCOUNTS or MAILSHOT. 
The filename can be followed by a full stop and an optional extension of up to 3 
characters. The extension is often used to indicate file types, say BASIC files, 

3



text files, GEM files, COBOL files and so on. Therefore the previous files could 

be named, FRED.GEM, FRED1.BAS, ACCOUNTS. COB, MAILSHOT. TXT 

Chapter 2 explains in greater detail how you can use these file identifiers. 

The erase command used in an earlier example was shown entered in capital 

letters but it could have been entered as 

ADErAse TemP.txT 

because DOS Plus ignores the distinction between capital and lower case 

letters. 

Files with names such as TXT, T.T, TEM.TX and Temp. tex will all be correctly 
identified as different files. But remember that temp. txt and TEMP. TXT will be 

identified as the same file. 

Although DOS Plus ignores the case of letters you do have to be very precise 

about spaces (and other punctuation characters) because these are interpreted 
as separators between items. For example: 

A>ERASE te mp.txt 

would give you an error message because the space after te would be 

interpreted as the end of the filename and DOS Plus won't find a file named te. 
Of course if you do happen to have named a file with the abbreviation te DOS 

Plus would act on the command and erase it. 

To summarise, a filename can be up to 8 characters with an optional 3 

character extension that usually indicates the file type. But to specify a file 

completely you should also identify where it is. In other words you should 

indicate which drive holds the disc containing the wanted file. 

Therefore, to specify the file TEMP.TXT you should really define it as 

A:TEMP.TXT, where the A: indicates that the file is on drive A. In practice if 

your selected drive is A (confirmed by the prompt A>) you can omit 

the A: from the filename and DOS Plus will automatically look for the file on 

drive A. However, if TEMP.TXT was in drive B you would need to 

specify B:TEMP.TXT or DOS Plus would fail to find the correct file. 

Extending this idea a little further, you can use a single command to perform 

several operations. For example 

AD>COPY B:temp.txt A:final.txt 

indicates that you want DOS Plus to copy TEMP. TXT from drive B to drive A and 

name it FINAL. TXT. Remember that the spaces mark where one file specifica- 
tion finishes and the next one starts. If you put an extra space after B: or A: the 

command will fail to produce the desired effect.



1.5 Conventions 

In this manual we have set out the examples of commands in the form that you 
would probably use. That is we've used lower case letters for filenames and 

we've left out anything such as drive letters that would be assumed by default. 

To ensure there is no ambiguity, we have included the prompt A> in each 

command, although you would not type that in. You might in fact be working 
with drive C (that is with C> as the prompt). 

Anything you type in is shown in a different typeface on a separate line, like 

this 

A>ERASE fred 

The symbol means press the key on the keyboard marked RETURN. 

For clarity we show commands in upper case and filenames in lower case as in 
the above example, but you would probably enter them both in the same case. 

A>erase temp.txt 

The next chapter covers loading and starting to use DOS Plus and it discusses 
the concept of default drives in more detail.



2 GETTING STARTED 
  

2.1 Introduction 

This chapter shows you how to load DOS Plus on your Master system and then 

illustrates some of the naming conventions and rules for DOS Plus commands 
and files. Your first job after loading DOS Plus is to make a backup copy of the 
DOS Plus boot disc and that process is described here too. 

If you have already been running an application that uses DOS Plus (for 

example GEM), you will already know how to load DOS Plus and you may 

already have taken a backup. In this case you may want to turn straight to 
section 2.5 of this chapter. 

To load and run DOS Plus you need the following: 

Master Series computer with a co-processor fitted 

At least one disc drive 

A copy of DOS Plus (on disc) 

A blank disc (for the backup copy) 

The co-processor is a printed circuit board housing an 80186 processor, which 

fits above the main circuit board in the Master series machine. It offers extra 
processing power to run computer languages, applications, and your own 

programs. For instructions on how to install the co-processor, refer to section 

7.3 in Part 1 (The GEM Collection) of this user guide. 

  

2.2 Loading DOS Plus 

1 Set up the microcomputer following the instructions in the Welcome Guide 
and turn it on. A message similar to the following should appear. 

Acorn MOS 

Acorn ADFS 

BASIC 

>



2 Put the DOS Plus boot disc in drive A. (This may be labelled ‘0' on the disc 
drive.) 

3 The computer doesn't yet know that the co-processor has been fitted. The 

computer communicates with the co-processor through a mechanism 

called the “TUBE” and the TUBE must be activated before the computer 
will recognise the co-processor. Do this by typing the command: 

>*CONFIGURE TUBE 

4 Then holding down [eac], press and release 

5 The screen ought to clear and then display a message like: 

boot strap Loader 

Loading DOS Plus ... 

Wait for a few moments while the operating system is loaded from the disc in 
drive A. 

6 The screen clears again and will display a new message something like: 

Acorn MASTER 512, DOS Plus 1.2 

Copyright (c) Digital Research 1985, 1986 

80186 Xios Ver 1.00, Acorn Computers 1986 

7 Finally the prompt, A>, appears which shows that DOS Plus is loaded and 

ready for use. 

Before you do anything further, it is sensible to make a backup copy of the DOS 

Plus disc, and store the original disc safely away. If you don’t take a copy you 

risk the problem of not being able to load DOS Plus if the original disc gets 

damaged or corrupted. 

The way to copy the software is different for floppy disc systems (see the next 

section) and hard disc based systems (see section 2.4). 

2.3 Copying DOS Plus - floppy 
disc system 

1 Type 

A>DISK 

and a menu of options will appear.



2 Choose the Format Diskette option, which is highlighted on the list that 
appears, by pressing 

3 You will now be asked which disc drive you want to format on. Insert a blank 
disc into the second disc drive (drive B) and press [Rerun]. (If you only have a 
single disc drive then remove your master disc from your disc drive and 

replace it with a blank disc. Next, using the cursor keys, highlight the 

Format on drive A option and press [return]. DISC will prompt you to swap 

dises at the appropriate time.) 

4 This leads to a menu of format options. Choose the 640 Kb [DOS] 

Bootable DOS Dise which is the one highlighted, by pressing [RETURN]. 

  

5 A message appears to confirm your choice; check and press for 

yes. 

6 The screen displays the formatting progress track by track. At the end you 

will see a message asking whether the disc is to be made bootable. 

Press for yes. If you have a single disc drive you will be asked to 
swap discs at this point. 

7 The verifying procedure then follows automatically. At the end the screen 
returns you to the format menu. Move the cursor to the Exit to main 

menu option by using the cursor keys and press [RETURN]. Repeat this 
and you will be at the main menu. 

8 Choose Copy Diskette from the main menu and press [RETURN]. 

9 Press to copy from drive A and then press again to copy 
to drive B. (If you have a single disc drive system you will have to use the 

cursor keys to copy from drive A to drive A. DISK will then prompt you to 

swap discs at the appropriate time.) 

10 Press to confirm your choice when the warning message 
appears. The screen displays the copying process. At the end, take out the 

freshly-copied disc, label it, and stick a write-protect tag over the notch on 

the disc. 

11 Use the cursor keys to select the Exit to DOS option and return to the A> 
prompt. Remove the original disc from drive A and store it in a safe place. 
Use the copied disc as your boot disc from now on.



2.4 Copying DOS Plus — hard 
disc system 

1 Check that the hard disc drive is properly fitted and formatted - consult 

the Winchester Disc Filing System User Guide for instructions if neces- 

sary. 

2 Load DOS Plus from your DOS Plus boot disc as described in section 2.2. 

3 Type the command: 

A>HDISK [RETURN 

4 The screen offers several different partition sizes: you don’t need to 
allocate all the available space to DOS Plus and you can change the size of 
the allocation later (Note, however, that doing this will involve the loss of 
all the data stored on the hard disc and so you will need to take backup 
discs before changing your hard disc partition size). 10 megabytes is a 

suitable size. When you've made your selection, press Press it 

again to confirm the choice. If a message reports that the disc is full, try 

allocating a smaller partition for DOS Plus. If you see a display saying 
that compaction is necessary, consult the Winchester Dise Filing System 
User Guide for instructions on compacting the disc. 

  

5 The screen displays the progress of the allocation process and lists the 
options again. Choose Make Bootable, press and then 

press again to confirm the choice. This copies DOS Plus onto the 
hard disc and reports progress. 

a Select the Exit to DOS option using the cursor keys. This returns you to 
the A> prompt. 

aS ‘Type the command 

A>COPY Azk.* Cz 

to copy your files from your master floppy disc on to your hard disc. 

oo Remove the DOS Plus boot disc and store it in a safe place. From now on 
you can load DOS Plus from the hard disc by pressing 

and simultaneously. 

   



2.5 Using DOS Plus 

We can now look at some of the features and conventions found in DOS Plus, by 
using a simple DOS Plus command. For convenience, in this section, we have 

assumed that drive A is the current default drive and, therefore, you will see 
the A> prompt at the front of each command; you don’t need to type this when 
you are typing the command line. Remember, too, to key a [Retuan] at the end of 
each command line. 

2.5.1 The DIR command 

The directory (DIR) command lists the files on a disc. To see the files already 
contained on your DOS Plus boot dise, type 

Ardir 

The screen should fill with a list of files, each of the form: 

DISK CMD 16640 16/04/86 9:13a 

This example indicates that the disc contains a file called DISK, which is a 
program file (this is indicated by the CMD file extension), that occupies 16,640 

bytes of store and was last changed at 9:13 am on April 16 1986, 

At the bottom of the listing is the number of files on the disc, the amount of free 
space (1 “byte” is equivalent to one typed character), and the message: 
system files exist ~ this message shows that other files are present on the 

disc but haven’t been displayed. System files aren’t displayed by the DIR 
command because they are used by the system itself, rather than by you. 

Next try typing, the command with some capital letters - for example: 

A>dir 
You will see the DOS Plus displays the directory listing again. DOS Plus 
ignores upper or lower case differences. You can enter commands in lower case, 

upper case, or any combination of the two. 

However, now try, 

wd ir 

This doesn’t work, and produces an error message, because DOS Plus 
recognises spaces as separators. Except in the file name — see also page 4 

(ERASE). 

2.5.2 Filenames and filetypes 

List the directory again by typing 

w>oIR 
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and now look at how the files are listed. Each has a filename, for example. 
“DISK”. (You will recognise DISK as the formatting/copying program you used 
earlier to make a backup of DOS Plus. DOS Plus permits filenames of up tc 
eight characters and using any combination of letters and numbers on the 

keyboard. Most other keyboard symbols will cause an error, because DOS Plus 

recognises them as having other uses. 

Each file should also have a filetype. DISK’s filetype is CMD, which, by 
convention, shows that DISK is a “command” file (ie a program) in DOS Plus. 

Filetypes can be up to three characters long and you can chose any combina- 

tion of letters and numbers, just as you can for filenames. However, you will 

find it useful to adopt some conventions for your filetypes. COM, CMD, and 

EXE filetypes are often used for program files. TEX or TXT is common for text 

files; BAK is standard for backup files of any kind. Applications will often 
generate files with readily identifiable filetypes — for example, GEM Paint 
creates files with an IMG extension. 

These “filetype” conventions do not actually mean anything in themselves - 

they are just a useful way of classifying files. You could, without creating ar 

error message, create files with random collections of 1, 2 or 3 character filetype 

extensions to their filenames. However, just as it is useful to give files sensible 

filenames, it is useful to give them sensible filetypes. 

Another advantage of filetype conventions is that they enable you to use 
‘wildcards’ in certain DOS Plus commands. 

For example, suppose you want a directory of all the command files on your 

disc. Type: 

A>DIR *.cmd 

The “wildcard” character * represents any character or group of characters in @ 

filename. If you type: 

A>DIR dx.* 

You will see this lists all the files beginning with d. Wildcards are described 

fully in section 4.3, 

As well as filename and filetype, the DIR listing displays the amount of disc 
space occupied by the file and the date and time it was created or last altered. 

2.5.3 Internal and external commands 
Look again at the DIR listing of DOS Plus boot disc by typing 

APDIR 
We have said that this lists all the command (ie program) files. Notice, 

however, that DIR itself is not listed. This is because DIR is one of many 
1



“internal commands”. Internal commands are loaded into the computer mem- 

ory whenever DOS Plus itself is loaded. The files listed on your screen are the 

DOS Plus “external commands”; they are only loaded from disc into the 
computer memory as you need them — generally, it is the large programs which 

are external. 

You could think of the internal commands as the ordinary instructions and the 

external commands as utility programs, but they are all used in the same way. 

The only practical difference between internal and external commands is that 

you don’t need the DOS Plus boot disc in the drive when you are using internal 

commands. However, if you try to use an external command without the DOS 

Plus boot disc in the drive, the screen will prompt you to insert the DOS Plus 

boot disc into drive A with the message: 

Not ready error reading driveA 

Abort or retry? 

2.5.4 Default drive 

Now try typing: 

A>b: 

Notice the screen prompt has changed to 

B> 

What you have done is change the “default drive” — the drive which DOS Plus 
automatically looks at if you don’t specify a drive. If you now try 

B>DIR 

you see the same error message as shown in 2.5.3, because DOS Plus looked for 

a disc in drive B and didn’t find one. 

If you want DOS Plus to look at a drive other than the default drive, simply 

include the drive name plus a colon when you type the command — for example: 

B>DIR a: 

  

This will list the contents of the DOS Plus boot disc that is in drive A, as before. 
But notice that the default drive stays unchanged until you specifically change 
it. You will continue to get the 8> prompt until you enter the command 

Boa: 

to switch the default drive back to A.



2.6 Leaving DOS Plus 

To leave DOS Plus and disconnect the TUBE, simply type: 

A>NOTUBE 

and the system returns to the familiar Master Series prompt.



3 DISC HANDLING 
  

3.1 Introduction 

This chapter looks at how you prepare discs and organise files, when using 

DOS Plus or applications that run under DOS Plus. You will be familiar with 

some of these procedures already, as they were introduced in the previous 

chapter when you copied the DOS Plus boot disc. Here we look at the whole 
process of formatting, verifying and copying discs. We also show you how to 

create families of files to simplify the storage and retrieval of data. 

3.2 Formatting and verifying 
discs under DOS Plus 

An unformatted disc contains neither files, nor data or any other meaningful 

signals. When you format a disc you simply lay down some basic control 

information that enables DOS Plus to identify areas of the disc quickly. It 
needs this information so that it knows where to save files and where to look 
when you want to retrieve them. The disc format also gives DOS Plus the basic 

information it needs to create and maintain a catalogue (or directory) of your 

files. 

Different operating systems, and different makes of computer running the 
same operating system all format discs in slightly different ways. DOS Plus 

accepts discs that are formatted either under the DOS or CP/M operating 

systems, as explained in Chapter 1. 

Once a disc has been formatted the operating system then verifies it to confirm 
that the process has been carried out correctly. Hard discs and floppy discs 
must all be formatted before they are used. Once formatted, a disc can be used 
indefinitely without reformatting. 

Caution: 

Formatting a disc destroys any information already on the disc. Remember 

too that a floppy disc can have only one format at any one time. You cannot



for example, have a disc containing a mixture of BBC-formatted files and 
DOS formatted files. 

DOS Plus allows you to format blank discs as either DOS or CP/M discs by 

using the DISK command. 

To use DISK, load DOS Plus as explained in Chapter 2 and type 

A>DISK 

When the menu screen appears press to select the format disk 

option. 

Press again to format on drive B, or use the cursor keys to choose 
drive A. 

This produces a new screen with several different choices for disc formats. 

Generally you will be using the Acorn-type formats, which prepare discs 

suitable for use on the Master 512. (The remaining options allow you to 
prepare discs in formats used on machines other than the BBC Master 512). 

The first option in the list: 

640KB [DOS] Bootable DOS disc 

is designed mainly for copying the DOS Plus boot disc. The one you will use 

most of the time is the next one: 

800Kb [DOS] Acorn DOS Format 

You might also use one of the other options 

400Kb [CP/M] Acorn Z80 Format 

if you have a Z80 second processor running CP/M. 

The choice of format depends on what you will be using the formatted disc for. 

Having decided which format you need, use the cursor keys or the space bar t¢ 

select the appropriate formatting option. 

Press and then follow the on-screen directions. 

Once formatted, the disc is automatically verified. 

3.3 Copying discs 

DOS Plus allows you to copy discs. A typical use for this is to make a backup 
copy of a disc as a safeguard against disc failure or accidental damage. You wil) 
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see later (Chapter 4) that DOS Plus also allows you to copy individual files or 
groups of files. 

To copy the contents of an existing dise on to a new blank disc, you must first 

format it as described in the previous section. (Note that the format chosen 

should be the same as that of the existing disc.) You then use the DISK 

command again. 

A>DISK 

and select the Copy Diskette option by using the cursor keys or the space bar. 
Then follow the on-screen instructions. 

3.4 Formatting and copying 
from within applications 

Some commercial applications that run on DOS Plus allow you to format discs 
and make backup copies from within the application. Note that the procedures 

may be different from those outlined here and you should refer to the 

manufacturer's documentation in each case. 

3.5 Organising your discs 

Once your discs are formatted correctly you can use them with your chosen 
applications. However, if you will be storing a large number of files on disc, you 

may find it helpful to organise your disc in some way, so that files can be stored 
within a logical structure. 

Under DOS Plus you can store files in directories (similar to the catalogues in 

the BBC format). DOS has two types of directory: root directories and 
subdirectories, and it is by using these that you can create a logical file 
structure. The root directory can be a master directory with as many levels of 

subdirectory beneath it as you wish. Using these directories you can find and 

store files easily and efficiently. 

For example, suppose three users, Tom, Dick and Barry, are writing memos, 
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reports and letters, and storing them all on the same disc. They might want a 
directory structure with two levels of subdirectory such as that outlined below. 

  

ROOT 

TOM DICK BARRY 

MEMOS LETTERS REPORTS REPORTS 

Tom files all his memos, letters and reports in separate subdirectories. Dick 

keeps his reports in one subdirectory and everything else in the subdirectory 
DICK. Barry hasn’t bothered to separate his work out and he stores all his 
different text files in the one subdirectory called BARRY. It is extremely 

difficult to keep track of the contents of files once they are on disc. You are 

advised in your own interests to use the subdirectory facility. 

Files such as address lists that Tom, Dick and Barry may all need to use are 

usually kept in the root directory. 

3.5.1 Creating a directory structure: the MKDIR 
command 

You can easily create a directory structure under DOS Plus by using the 
MKDIR command. MKDIR creates as many subdirectories as you like, and you 

can create directories whenever you like, so that your filing system grows wit! 
the contents of the disc. (Note that there are limits to the number o 
subdirectories you may have, but you are unlikely to reach these in normal dis: 

use). 

MKDIR commands are all of the following form: 

A>MKDIR {drive}<path to new directory>directory name 

So, to create subdirectory TOM in the above example you would need to type: 

A>MKDIR \TOM 

where \ stands for the root directory. To create MEMOS as a subdirectory ¢ 

TOM you need to specify the location of the new subdirectory in relation to 
(the root) and TOM. So you would type: 

ADMKDIR \TOM\MEMOS 

In this case the path from the root directory to the new directory is ROOT 

TOM-MEMOS and the DOS Plus syntax for that path is \TOM\MEMOS



Similarly, to create Tom’s subdirectory LETTERS, type: 

A>MKDIR \TOM\LETTERS 

Tom's directory structure is then completed by creating his REPORTS sub- 

directory: 

A>MKDIR \TOM\REPORTS 

  

Dick’s subdirectory structure is created in the same way: 

ADMKDIR \DICK 

(this creates DICK as a root directory of the subdirectory) 

A>MKDIR \DICK\REPORTS 

(this creates REPORTS as a DICK’s subdirectory) 

3.5.2 Displaying a directory structure: the TREE 
command 

The TREE command displays all the subdirectories on a specified disc. 

Example: 

ADTREE b: 

displays the directory structure of the disc in drive B. If you don’t specify a 
drive, TREE displays the subdirectories in the default drive. 

3.5.3 Using subdirectories: the CHDIR and PATH 
commands 

Each time you try to access a file, DOS Plus looks for it in the current directory, 
unless you specify otherwise. The root directory is the ‘current’ directory at the 

beginning of each DOS Plus session. 

However, if you are using a directory structure, most of your files will be in 
subdirectories rather than the root directory. If you want DOS Plus to look in a 

specified subdirectory, rather than in the root directory use the CHDIR 

command. 

The CHDIR command 
CHDIR changes the current directory, so that DOS Plus looks for a file in your 

specified subdirectory rather than in the root directory. That directory remains 

the current directory until you change it with another CHDIR command or 

finish your DOS Plus session. 

You can use CHDIR in a similar way to MKDIR, and specify the path from the 

root directory to the subdirectory. For instance, in our example, if Dick wants 
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his REPORTS directory to be the current directory, he can type: 

A>CHDIR \DICKREPORTS 

and DOS Plus will access files on his REPORTS directory (and nowhere else 
until he specifies another subdirectory to be the current directory. 

The PATH command 

Sometimes it’s useful to tell DOS Plus to look for a file in several subdirector- 
ies. You can do this with the PATH command. After you've set a PATH 

command, DOS Plus will look for a file first in the current directory, and then 

in the list of subdirectories you specified in the PATH command. 

Note: 

PATH only works for executable files (programs) with CMD, COM, EXE, 

or BAT filetypes. For other files (such as text files), DOS Plus will only look 

in the current directory. 

For example: 

A>PATH \TOMREPORTS ,\DICKREPORTS; BARRY ;B:\ 

  

This will cause DOS Plus to look first on the current directory (whatever that 

is) and then in TOM’s REPORTS directory. It will then go to DICK’S 
REPORTS directory and then to directory BARRY. Finally it will go to the root 
directory in Drive B. Note that 

@ each directory in the PATH list is separated by semicolons in the PATH 

command and 

@ PATH will search drives other than the default drive. 

To display the current PATH setting simply type: 

A>PATH 

To cancel the current PATH setting type: 

ADPATH; 

Ifno PATH is set, or the PATH setting is cancelled, DOS Plus will only look for 

a file on the current directory. 

3.5.4 Deleting directories: the RMDIR command 

RMDIR removes a subdirectory from the specified disc. Before using RMDIF 
you must remove any files that are in the subdirectory. 

Note: 
DOS Plus creates two files on each subdirectory for its own use; one it 
called ’’ and the other ’..’. These can’t be removed and you can ignort 

them.)



nxampie: 
provided all files have been removed from the subdirectory MEMOS, the 
following command removes it from the disc 

A>RMDIR \TOMMEMOS 
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4 FILE HANDLING AND 
PRINTING 
  

4.1 Introduction 

DOS Plus offers powerful file handling features: you can use DOS Plus for al 

the things you might want to do such as copying files, or combining several file: 

into one, as well as erasing files when you don’t need them any more, 0 

renaming them as your filing system structure develops. You can also ‘print 

text files on the console screen or on a printer. 

Files are usually created by applications programs rather than by DOS Plu: 
itself. We will see later how you can create files with DOS Plus, using eithe 
the COPY or ED commands. In this chapter, however, we will concentrate or 
using DOS Plus in file management with existing files. 

4.2 Copying files 

The COPY command enables you to copy a file on to another disc, drive 01 
directory. The original file remains intact. 

Suppose you want a copy of the file filename.ext on another disc. Put the 
original disc (the source disc) into one drive, say drive A, and then type: 

A>COPY a:filename.ext b: 

  

The screen will then prompt you to insert a disc into drive B (because you 
specified b: in the command as the destination). COPY works equally wel 

with systems containing one or two floppy disc drives, or a Winchester hare 

disc drive; the Winchester is typically referred to as drive C. 

COPY differs from the copying option found in the DISK command. That optior 
is designed for producing backup copies of entire discs. Use COPY when you 

want to process single files or groups of files: 

@ COPY doesn’t automatically copy the whole disc. You can choose whick 
files you want to copy. 
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@ COPY only overwrites existing files of the same name on the target 
disc, DISK will overwrite all files on the target disc. 

COPY is a powerful DOS Plus command which can do more than we have 

described here. (See section 4.5 for a use of COPY in combining files, and 
section 5.2 for creating files using COPY CON:). COPY can be used to move 
copies of files to or from a printer, keyboard, console or auxiliary device such as 
a modem. For information on these functions, see the full DOS Plus manual. 

You can use wildcard characters to copy groups of files. For example, suppose 
you have many files on a hard disc and you want to take a disc of all the letters 
sent to Belgium (which you have identified by the blg extension), type: 

ADCOPY cz*.blg a: 

The * character matches all letters in a filename, so *.blg identifies and copies 

all the files with the blg extension (see next section for full details). 

4.3 Using wildcards 

If you are performing the same operation on a number of similar files, DOS 
Plus provides a shortcut that will save you typing in a string of similar 
commands. “Wildcard” characters can replace some or all of the characters of 
the filenames specified in most commands. 

Two wildcards are provided in DOS Plus: 

@ The? character which replaces a single letter in a file specification 

@ The* character which replaces several letters in a file specification. 

These characters can be used separately or together to create ambiguous file 

specifications. 

For example, suppose you have the following files in a directory on drive A: 

reports1.jja 

reports2.jja 

reports3.jja 

memo. jja 
address. jja 

reports1.amk 

reports2.amk 

amemo.amk 

bmemo.amk 

report 
report10.jja 
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You could use wildcards in several ways: 

  

A>DIR reports?.* 

lists all the files that begin with the letters “REPORTS”, followed by one (or no) 
character and have any (or no) file extension. That is, it will list reports! ja, 
reports2.jja, reports3,jja, reportsl.amk and reports2.amk. It would miss 
report10,jja and report. You would need report??.* to catch those. 

A>COPY a: 2memo.amk b: 

Copies amemo.amk and bmemo.amk from drive A onto drive B. 

ADDIR re.jja 

or 

or 
   

A>DIR rep*.?j? 

or several other combinations would all list reportsl.jja, reports2.ja, 

reports3,jja and report10.jja, but not reportsl.amk or reports2.amk 

Remember that wildcards can only be used in filenames and file extensions, not 

as drive specifiers or in typing DOS Plus command names. DOS Plus only uses 
wildcards as a pattern when it is searching a disc directory, so a few commands 
do not permit wildcard characters. 

4.4 Renaming files 

The RENAME command simply changes a file’s name. You can change the 
filename, the filename extension, or both. 

To rename a file, inset the disc that contains the file you want to rename and 

type, for example: 

APRENAME oldfile.ext newfile.ext 

This will rename the file oldfile.ext as newfile.ext. The renamed file stays in 

the same drive (and directory), which in this example is drive A. 

Notes: 

1 You can abbreviate RENAME to REN



2 You can rename a file that is on a different drive by adding the drive letter 

before the old file name, for example: 

A>REN b:oldfile.ext newfile.ext [RETURN] 

3 RENAME permits wildcards — see section 4.2 above — so that you can 
rename a series of files. For example: 

A>REN b:#.tex #.bak 

This will rename all your tex files on drive B as bak files. 

4.5 Combining files 

You can use COPY to combine several small files into a larger one. 

Put into drive A the disc containing the files you want to combine and type 

A>COPY filel.ext+file2.ext newfile.ext [RETURN] 

This copies the contents of filel.ext and file2.ext into a new file called 

newfile.ext on the same drive. Note the space before newfile.ext that signals 

the end of the source file list. You can also copy to or from a different drive by 

adding drive letters. For example: 

ADCOPY filel.ext+filez.ext binewfile.ext 

copies from the default drive onto drive B. 

The original filel.ext and file2.ext are left intact (you can erase them if you 
want to by using the ERAQ command as described below.) 

4.6 Erasing files 

The ERAQ command erases files from a disc. Use this command carefully, 

because once a file is erased it is lost completely. 

To erase a file, insert into drive A the disc containing the file you want to erase 
and type 

A>ERAQ filename.ext 
Po



'lhis produces the message: 

filename.ext (Y/N)? 

Check the filename to make sure it is correct, and they type y to erase the file 

(or any other key to leave it untouched). 

You can delete several files in a series by using wildcards. This saves you 

typing in a long list of similar commands. For example if you wanted to delete 
all the backup files from a dise you could enter 

ERAQ*.bak 

Use ERAQ in this way if you want to keep one or two bak files but delete the 

rest. 

There is another command, ERA, that works in a very similar way to ERAQ 

except that ERA deletes the files without questioning you. ERAQ is safer 
because it gives you the chance to check before it’s too late. 

4.7 Displaying files 

TYPE displays the contents of a specified text file on your screen, or at the 

printer, or both. 

To use TYPE, insert, into drive A for example, the disc containing the file you 
want to display and type: 

A>TYPE filename.ext 

This scrolls the text of the file up the screen. Press and S to interrupt 
the listing and and Q to resume. 

  

If you want to display a screenful of text at a time, type /P: 

A>TYPE filename.ext /p 

To list the file at a printer as well as on the screen, type and P before 

entering the TYPE command. To stop the printer at any time, type a second 
and P. The listing will continue on the screen. 

 



5 CREATING AND 
EDITING FILES 
  

5.1 Introduction 

Generally speaking, you will be creating and editing files within your applica- 

tion programs. For example, you would normally create text files using your 

word processor, program files using your compiler program, record files using 

your database program, and so on. And then you would change those files 

using the same application program that you used to create it. 

However, sometimes you may want to create or edit text files in DOS Plus, 

perhaps because you want to run a batch program as described in the next 

chapter. There are two ways of creating a text file in DOS Plus: you can either 

‘copy’ it from the keyboard or use the ED text editor to type it into a file. 

  

5.2 COPY CON 

The COPY command is used to copy files between discs, as described in 

Chapter 4, but it can also be used to copy files to and from other devices such as 

a printer, screen or keyboard. Therefore, you can ‘copy’ a file from the keyboard 

into a file on disc, thus creating a file. 

To do this you specify the source file (where the file originates) as CON: (the 

console), in a statement such as: 

A>COPY CON: batch.bat 

Whatever you type in after will then be recorded in the file batch.bat 
on drive A. You can type in anything you want, and it might typically be a few 

lines of DOS Plus commands. 

At the end of the last line, enter and Z (press Z whilst holding down 
the key) instead of and you will be returned to the command 
line prompt, A>. You have created a text file batch.bat that contains the 

characters you typed in and can be processed in the same way as any text file. 

  

So, COPY CON: is a quick and easy way of creating files. However, you cannot 

26



correct typing errors during the copy, so you need to be very careful, and 
therefore, this method is practical only for text files of a few lines. The ED text 

editor is probably easier to use for creating larger text files, and you can also 

use ED for correcting errors in your COPY CON: text file. 

5.3 The ED Text Editor 

The text editor, ED, can be used to create text files or to edit existing text files. 

It is designed as a programmers’ editor rather than for word-processing as 
such. ED is a comprehensive editing program, and only the basic writing and 

editing commands are documented here. These facilities are described in the 
DOS Plus Users’ Guide and the DOS Plus Programmers’ Reference Guide. 

If you wanted to create a new file called (for example) batch.tex. You would call 

the editor with the command: 

A>ED batch. tex 

A new file, batch.tex would then be opened and you would see the ED prompt 

asterisk on the left hand side of the screen. 

You are in the ED command mode after typing the above command, so any 

characters you type will be interpreted as commands by DOS Plus. So the first 
thing to do is put ED into insert mode by typing: 

ii 

Now type in the text you want (ignoring any typing errors for the moment), and 
when you have finished press and Z to change back into command 
mode, indicated by the :*. 

Your text is now stored in a buffer. To write your text to your file batch.bat, 

enter the command: 

ite 

which ends the edit session. You now have a file batch.tex on the disc in drive 
A. 

If you now want to edit your file, call ED again: 

A>ED batch.tex 

ED now displays 

i 

to show that its pointer (an imaginary cursor) is at the beginning of the buffer. 
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First you want to bring the text into the buffer by entering 

re#a 

  

Then to display the contents of the buffer on the screen. You do this by entering 
the ‘page’ command that moves the pointer to the end of a 23-line ‘page’ of text: 

=O 
Now you can move the pointer to the place in the file that you want to edit with 
the commands: 

nl to move the pointer up or down by n lines, and 

nc to move the pointer right or left by n characters. 

For example: 

4 
r+-8c 

will move the pointer down four lines and left eight places. And: 

ze-2L [Rerunn] 
r#3-¢ 

will move the pointer up two lines and right three places. 

At any point 

2p 

will display the text to the right and below the current pointer position. 

Once you have the pointer where you want it, you can insert characters (by 

using the command i followed by the characters, followed by and Z), to 

delete characters using the command d with a number to indicate how many 
characters to delete. For example: 

soot (RE 
will erase the four characters on the left of the cursor position. 

  

If you get confused 

4b 
will move your pointer to the start of the buffer. 

Carry on in this way until you are happy with the text and then use the 
command e to end the editing sequence and write your text from the buffer into 

the file. ED will, as a precaution, retain the original, unedited file and change 
its filetype to bak to signify that it is a backup file — so in our example the 

original file batch.tex would be renamed as batch.bak. 
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In some cases you may want to use a fuller version of ED, specifying a 
destination filename as well as a source filename, for example: 

A>ED B:source.tex Aznewname.tex 

In this case file source.tex on drive B will be preserved intact and the edited 
version of source.tex will be written to the file newname.tex on the drive A. 

This description of ED has assumed that you are creating and editing small 

files (less than 23 lines in length), and therefore has given only a few of the ED 
commands. In fact you can do quite complex things with ED such as searching 

for strings of characters, substituting strings, deleting lines, repeating a group 
of commands, and so on. 
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6 DOS PLUS AND 
APPLICATIONS 
  

6.1 Introduction 

This chapter outlines some general features of running applications programs 
under DOS Plus. You will also find ideas on how to minimise some of the 
repetitive tasks involved in using your Master with an applications package. 

6.2 Running applications under 
DOS Plus 

An application is any program or set of programs that enables you to perform a 

specific task. Many commercial applications are available — spreadsheets for 

your accounts, word processing packages for your letters, databases for your 

records, or multi-purpose packages which do all three. Or you may have 
written your own application to run under DOS Plus. 

Whatever the task is, and whatever your chosen application, you can treat it as 

a program, needing some sort of organised input, and producing some sort of 

organised output. The process is always the same. To run the program you need 

to switch on the computer, load DOS Plus, load the program, enter the input, 

produce the output, leave the program, perhaps tidy up and file the output, 
leave DOS Plus and switch off the computer. 

In the simplest case, you use DOS Plus just to run the application program: all 
you have to do is type the program name on the command line. For example, 
suppose you have bought a word processing package called EXAMPLE. 

Running EXAMPLE involves the following steps: 

@ Load DOS Plus 

@ Load EXAMPLE by entering: 

A>EXAMPLE 

@ Create, edit, print files using EXAMPLE 
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@ Leave EXAMPLE 

You have done everything you want using the application itself, including 
saving, sorting and deleting your text files. 

6.3 Configuring, entering and 

leaving applications 

There are, however, three ways in which your life with EXAMPLE may not be 

quite so simple: 

1 EXAMPLE may be a general purpose program that needs to be tailored fe 

your particular configuration. Typically you might need to give specifi 

details of your printer and the amount of memory you have available. Thi 

whole process is known as ‘configuring’ your application. 

2 EXAMPLE may not include all the facilities you want for handling you 
files. Typically you might want to look at the DIR listing of a particular dis 

to see if it’s the one you need or to remind yourself of a particular filename 

This means leaving the application, using DOS Plus commands, and the 
re-entering the application where you left it. 

3 Similarly, after you have finished with an application, you may want to do 
some ‘housekeeping’ tasks that you can’t do within the application. For 
example, you may want to backup all your files on disc, or process selected 
files to use as input for another application. 

In the first case, what you need to do depends very much on the particular 
application. In other cases, the documentation provided with the package will 
enable you to configure the package for your Master 512. More than likely, you 
will be able to ‘save’ this configured version of the application, so you need only 
go through the exercise once. 

In the second case, you need to ensure that you leave the application tidily, so 
that you do not lose any files or waste any of your work. So follow the procedure 
as if you had finished the task, quitting the application in the usual way. When 
you restart, you may have to repeat some activities or go through some file 
opening exercise again to get back to your exit point. 

A few applications, such as GEM, allow you to break off and return to the 
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application without having to re-load it. Such applications make use of the 
DOS Plus EXIT command, If you are running an application that allows you to 

use EXIT, and you are in DOS Plus, and you want to return to the application, 

simply type: 

A>EXIT 

and you will return to the application without reloading the program. 

In the third case, your concern is probably one of efficiency, file security or 

storage space (or a mixture of all three). All three involve moving, erasing and 
duplicating files using the DOS Plus commands covered in earlier chapters. 
But bear in mind that sensible use of filetype extensions and wildcard 
characters can make housekeeping quite easy. You might also consider using a 
‘batch file’ if you are continually doing the same kind of routine job that 
involves a series of DOS Plus commands —~ see the next section. 

6.4 Automatic loading and batch 
files 

So far we have considered using an application as an occasional exercise. You 
might, however, use a particular application (say word processing) almost all 
the time. If so, you may be able to save yourself some time by writing a 
program such that the application is loaded automatically when you load DOS 
Plus. 

Such a program is an example of a ‘batch file’ — that is, a file containing a list of 
DOS Plus commands which DOS Plus reads to save you entering each 
command individually from the keyboard. A batch program used for a startup 

sequence is often called an AUTOEXEC.BAT batch file. 

You can create an AUTOEXEC.BAT file (or any batch file) using a word 
processing program or editor and then store it in the current directory on the 

DOS Plus boot dise (or hard disc). The file can contain any DOS Plus 
commands, and they will be executed automatically as soon as DOS Plus is 
loaded. The effect is, therefore, as if you had loaded the application directly. 

Batch files allow you to display remarks on the screen as the batch file is being 
executed, and also have a facility for pausing whilst you change discs, for 
example, or type in some information such as the current date. 

Below is an example of an AUTOEXEC.BAT file which will automatically run 

after you load DOS Plus, change the default drive to B, prompt you to insert 
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the disc containing your word processing program EXAMPLE, and then loac 
EXAMPLE. (REM is the batch programming command for ‘remark’): 

REM Ready to load word processor EXAMPLE... 
B: 

PAUSE Insert EXAMPLE Disk in Drive B 

EXAMPLE 

You might want to create another batch file for the disc housekeeping 
purposes. For example, at the end of each day’s work you may want to storc 
your files on a backup disc. Below is a batch file that would do this for you. Ii 

assumes that all the files you want to backup have the XWP (for example 
filetype. 

PAUSE load work disk in drive A 

PAUSE load backup disk in drive B 

COPY A:*.XWP B:*.BAK 

REM Copy finished. Don't forget to take out the disks. 

If you called this file, say ENDOFDAY.BAT, you could run it simply by typing 
the command: 

A>ENDOFDAY 

after you have left the application you were using. It would prompt you to 
insert the appropriate discs, perform the copy operation, and then prompt you 
to remove the discs before returning you to the A> prompt so that you can 

switch off. 

You can put any valid DOS Plus command into a batch file, and there are 

several powerful batch programming commands in addition to REM and 

PAUSE. Some of these are mentioned in Chapter 8 and all of them can be found 
in the DOS Plus Users’ Guide and the DOS Plus Programmers’ Reference 
Guide. 
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7 OTHER FACILITIES IN 
DOS PLUS 
  

7.1 Introduction 

This chapter looks at some features of DOS Plus that are unique to the BBC 
Master. 

7.2 Passing commands to the 
BBC Operating System 

The utility STAR allows you to pass commands to the BBC Operating System. 

WARNING 

Make sure that you are clear exactly what you are doing when you use the 

STAR command as incorrect use could lead to serious loss of data. 

If you type: 

ADSTAR 

you will receive the prompt 

* 

You can then enter a command (such as CAT for example) that is recognised by 

the BBC Operating System. The * prompt will continue to appear until you 
enter 

& 

when you will be returned to the normal DOS Plus prompt. 

If you want to use a single * command, such as CAT, and then return directly 
to DOS Plus, you can type 

A>STAR CAT 
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7.3 Copying files between DOS 

Plus and BBC formats 

If you wish to copy files from BBC format to or from DOS Plus. 

with the GETFILE and PUTFILE commands. GETFILE copi 

Master filing systems to DOS Plus and PUTFILE copies from DOS Plus to BBC 

filing systems. 

    

vw    For example: 

ADGETFILE :1.fred Azjim [Ri 

  

copies the file fred from ADFS format in drive 1 to DOS Plus format in drive A, 
and renames it jim 

A>PUTFILE A:letter :3.letter /disc 

copies the file letter from DOS format in drive A: to DFS format in drive :3 

7.4 Using DOS Plus for screen 
emulation 

PCSCREEN allows you to select an IBM screen emulation mode. The main use 
of this is to reset to the mode after a program has changed it. 

Modes 0-6 emulate modes on an IBM Colour Card. Mode 7 is the native BBC 
80x25 text mode. 

For example: 

A>PCSCREEN 7 

sets you to screen mode 7. 

7.5 Altering the screen colours 

COLOUR allows you to change the screen colours between various options. 

The command has the form 

A>COLOUR x y



The options for x are: 

0 — 80 column background 

1 — 80 column foreground 

a — GEM background 

3 — GEM foreground 

4 to 7 —4 colour modes 

The second number is the physical colour to be displayed. The options are: 

0 —black 8 — flashing black / white 

1—red 9 — flashing red / cyan 

2—green 10 — flashing green / magenta 

3— yellow 11 — flashing yellow / blue 

4—blue 12— flashing blue / yellow 

5 — magenta 13 — flashing magenta / green 

6—cyan 14 — flashing cyan / red 

7 —white 15 — flashing white / black 

These colours remain set throughout a DOS session. The default choices are 
white on black. 

For example: 

A>COLOUR 0 2 

A>COLOUR 1 0 

This produces black text on a green background.



8 THE NEXT STEP 
  

8.1 Introduction 

This manual has given you the basic information you need to run applications 
under DOS Plus. It has concentrated on the commands most frequently used 
for file manipulation 

However, DOS Plus has far more facilities than can be covered here. It has 
other commands and facilities, and there are more versatile and complex forms 

of the commands you've already met. Whatever you might want to do with 

DOS Plus, there is almost certainly a way of doing it. 

This chapter very briefly outlines some of these extra facilities. You will find 

full details in the Digital Research’s DOS Plus Users’ Guide. 

8.2 Advanced file copy facilities: 
COPY and PIP 

The COPY command can include options to the files you specify. For example, 

the + option has already been described in Chapter 4. It is used to combine 
several files into one file. The most useful of the remaining options is probably 
/V, which compares source and destination files. For example. 

A>COPY <sourcefile> <destfile> /V 

will cause the newly copied file destfile to be verified against sourcefile, to 
check that the copy is complete and accurate. (Note that the copying will take 

longer because of the verification stage). 

You may also find the /A and /B options useful if you want to read or write 

ASCII text files. For example: 

A>COPY <sourcefile> <destfile> /A 

causes the destination file to be written as an ASCII (text) file followed by an 
end-of-file character . On a source file /A will copy characters up to 
the first ([eTa-z], and then ignore anything that follows. /B has the same 
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effect except that it ignores any characters in a source file, and 
doesn’t add a to a destination file. 

COPY can also be used to copy files between disc, keyboard, screen and printer 
by specifying an output device. In Chapter 5 the device name CON: was used to 
create a file by ‘copying’ it from the keyboard. You can also use CON: instead of 
the destination filename to display files on the console screen. For example: 

A>COPY Brmyfile con: 

displays the file on the screen. 

Perhaps more useful is the device name PRN: which you can use to copy ASCII 

(text) files onto your printer: 

A>COPY *.txt PRN: 

gives you a printed copy of all the txt files from the disc in drive A. 

Another command that performs much the same operations as COPY is the 
Peripheral Interchange Program (PIP). PIP is one of the most powerful and 

versatile DOS Plus commands. It takes the basic form: 

A>PIP <destfile>=<sourcefile> 

but allows you to specify twenty or so different options to process your files 
while they are being copied. You can also specify ‘auxiliary’ devices such as 

printer or keyboard for the source and destination of the file. In addition, if you 

have a sequence of copying commands to enter, you can save time by using PIP 
in a multiple command mode. This saves you from loading the program into 

memory for each copy operation. 

Here are some of the PIP options: 

[A] is the archive option, which will only copy files that have been modified 
since the last backup operation. 

[C] asks you to confirm each file before the copy operation, so that you can 
selectively copy files or groups of files. 

(L] after the sourcefile changes all uppercase characters in the sourcefile to 

lowercase in the destination file. [U] will achieve the opposite, changing 
lowercase to uppercase in the destination file. 

8.3 Background Programs 
DOS Plus allows you to run certain programs in the background. This means 

that you can run your applications using the screen and keyboard as usual, but 

up to three other programs may be running (fairly slowly) at the same time. 
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This is possible because the memory and the computer processor are shared 
between the various background programs and the foreground program, DOS 
Plus manages the use of store and processing power in such a way that youmay 
not even notice that your foreground program is running a bit more slowly than 
usual. (In fact you can use commands ADDMEM, COMSIZE and SLICE to 

specify different timesharing rates to suit your particular requirements.) 

You are kept informed of what is happening in the background via the BACKG 
command, which displays the names and current status of your background 

programs. For a status display, type: 

A>BACKG 

Two background programs are provided with DOS Plus: ALARM (a diary/ 
alarm facility) and PRINT. 

8.3.1 The ALARM command 

The ALARM command enables you to send yourself messages at specified 
times and days. It is a background program that can be used as a diary or 
‘bring up’ reminder. 

The options are: 

ADALARM 

This will display a list of the alarms currently set, and whether ALARM is ON 

or OFF. 

A>ALARM <date time message> 

This adds the specified alarm to the ALARM list, and starts ALARM running if 

it isn’t already. If you don’t specify a date, the current date is chosen. 

For example: 

A>ALARM 16/02/86 1:00 Lunch at the Unicorn 

will add that message to the list. At the specified time (if ALARM is running) 
the computer will beep and display the message on the screen. 

A>ALARM <date time> /C 

This cancels the specified alarm. The /T option deletes all the entries and 
terminates the program. Finally: 

A>ALARM /ON 

starts ALARM running and 

A>ALARM /OFF 

stops the program but retains the alarm entries. 
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8.3.2 The PRINT command 

PRINT allows you to print files while you are working on another program in 

the foreground. 

For example: 

A>PRINT chapter1.tex 

starts printing chapterl.tex and enables you to carry on writing (say) 

chapter2.tex. If you finish chapter2.tex before PRINT has finished printing 

chapter1.tex, simply type: 

A>PRINT chapter2.tex 

PRINT will add the file to a print queue, and print it when it has finished with 

chapterl.tex. Up to 32 files may be queued in this way at any one time. 

Alternatively you can type in the whole print queue at once: 

A>PRINT one.tex two.tex three.tex four.tex 

To remove a file from the print queue at any time, use the /C option, for 

example: 

A>PRINT three.tex /C 

will remove three.tex from the print queue. 

Note: 
You cannot remove an entry while it is being printed, but only ifit is waiting to 

be printed. 

PRINT also errmpncts wildcard file specifications. For example: 

A>PRINT *.bak 

will print all files with the bak filetype. 

Note: 
If you are using a directory structure, all the files you specify in a PRINT 

command must be in the current directory when the PRINT command is 

issued. 

Use the /T option to terminate the PRINT program: 

A>PRINT /T 

8.3.3 Other Background Programs 

You can develop your own programs to run in the background. See the DOS 

Plus Programmers’ Reference Manual for details. 
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8.4 Changing the prompt — the 
PROMPT command 

The PROMPT command enables you to change the standard prompt from (for 
example) A> to anything you want. It has the form: 

A>PROMPT <text> 

where <text> can be any characer string except $,=,<,>, or | 

For example: 

A>PROMPT Type command here: 

will cause A> to be replaced by: 

Type command here: 

until you change the prompt. 

In addition, you can include certain special strings, indicating them with the $ 
character. The special strings are: 

the time 
the date 
the current directory 
the version of DOS Plus 
the default drive letter 
the user number 
the $ character 
the > character 
the < character 
the | character 
the = character 
the escape character (ESC) 
backspace r

e
a
r
m
t
-
m
e
c
s
 

<
t
 
A
s
 

Any other character following $ is ignored. PROMPT without any text resets 

the prompt to the default DOS Plus prompt. 

For example: 

A>PROMPT $p$q 

sets the prompt to the current directory level followed by the > character: 

\TOM\MEMOS> 
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8.5 More on batch programs 

In Chapter 6 batch programs were introduced as a text file of commands that 
can be executed by entering the filename. The subcommands REM and PAUSE 
were also introduced. 

Batch programs can be made more useful by introducing some other subcom- 
mands, and by using variables, 

Briefly, some other subcommands are: 

ECHO 

GOTO 
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Normally commands are displayed on the screen as they are 

executed. ECHO OFF and ECHO ON can be used to switch this 
display off and on again. ECHO message will substitute a message 
for the commands. 

If you add labels to your file, that is, any string of up to 8 
characters preceded by a colon, you can branch to the command 
after that label, for example: 
GOTO ERROR 

TERROR REM Error sequence 

This takes the form: 

IF {NOT} <condition> <command> 

where NOT is optional. The condition can be either: 

<string1>==<string2> 

or 

EXIST <filespec> 

If the condition is true, then the command is executed. 

For example: 

IF EXIST temp.tex ECHO file found [Rerun] 

or 

IF %XI==0K REN fred jim 

where %%I is a variable that contains a string.



You can also pass parameters to a batch program by using any of the ten 

variables %1 to %9. For example: 

A>COPY CON: Listing.bat [RetuaN] 

COPY %1.txt %2.txt 

TYPE 20 
A>Listing prog1 B:prog2 [retuan] 

Listing would replace %0, prog! would replace %1 and B:prog2 would replace 
%2. The listing on the screen of listing.bat would be: 

COPY PROG1.TXT B:PROG2.TXT 

TYPE LISTING.BAT 

otherwise File not found. 

8.6 Other commands 

Some of the other DOS Plus commands are: 

CLS: clears the screen of the current display. 

DATE: displays and changes the date 

TIME: displays and changes the time. 

FSET: sets file and drive-related attributes such as Read Only and Read/Write 

SDIR: displays extra information about file status 

SET: displays and changes the DOS Plus environment buffer, for example to 
change the number of lines or the length of lines displayed on the screen. 

DEVICE: changes character device characteristics e.g. sets up serial line 
BAUD rates. 

This selection of commands is intended to illustrate how DOS Plus can be used 
to achieve some very complex operations with a fairly small number of 
commands. Almost anything can be done, but you need to understand DOS 
Plus (and your applications) very well before attempting anything really 

sophisticated. The few commands described in the early chapters of this book 
will probably suffice for most of your activites. 
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BYE 

Use the BYE command to park the heads on your hard disc before switching it 
off. 

Syntax: 
BYE 

Explanation: 

To prolong the life of your hard disc you should issue this command before 
switching off. The result is the disc drive heads are moved to a special parking 
zone on the disc. If you do not issue this command the drive heads can come to 
rest anywhere, potentially causing damage. This command need not be used on 
floppy only systems. 

Example: 

C>BYE 

CHKDSK 

Check the integrity of a DOS disc. 

Syntax: 

CHKDSK {d:} 

Explanation: 

This command will check a DOS dise and give you information on how the 

space is being used. If any faults are uncovered then CHKDSK can also be used 

to fix these. 

Example: 

A>CHKDSK C: 

10,592,596 bytes total disk space 

65,536 bytes in 5 hidden files 
167,936 bytes in 41 directories 

10,227,712 bytes in 846 user files 

131,072 bytes available on disk 

MEMDISK 

Installs a Memory Disc as drive M. 

Syntax: 
MEMDISK {n} 

Explanation: 

The MEMDISK command tells DOS Plus you want to set aside some of your 
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memory to be a very fast disc. This is sometimes known as a RAM disc. When 

you have installed a Memory Disc you can use drive M as you would any other 

dise. 

The default disc size is 128k but you can specify other sizes, always assuming 
you have enough free memory. BACKG will tell you how much you have free 

but remember you will need some to run programs. MEMDISK will not accept 

values that leave you with no free memory but remember that some 

applications (e.g. GEM), require all the memory and you cannot have even a 
small Memory Disc. 

Example: 

A>MEMDISK 160 

Creates a 160k Memory Disc. 

NETPRINT 

This allows you to print files on a BBC Econet Print Server. 

Syntax: 

NETPRINT filename {filename2 filename3...} 

Explanation: 

Normally a printer is connected directly to your Master. If you wish to use an 

Econet Print Server instead you can use the NETPRINT command to send files 

to the remote printer. 

Example: 

A>NETPRINT FRED.TXT 

8.7 IBM keypad emulation 

The Master 128 has a number pad which has been adapted to produce the same 
character codes as many IBM special keys. Those keys used in software are 
shown on the key card supplied with the machine. The omissions are those keys 
which affect the IBM hardware i.e. Scroll Lock, NumLock and PrtSc. The 
character code for these keys is implemented but it is up to the particular 
applications programs to make use of them. The equivalent keys on the 

number pad are: #, / and * respectively. The NumLock key is implemented on 
the CAPS LOCK key on the main keyboard. 
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It should be noted that to implement the BREAK key on the keypad, the CTRL 

key must also be held down when pressing #. 

8.8 The Z80 Emulator 

Type: 

A>Z8B [Re 

and you will enter the Z80 Emulator. You have available the standard CP/M 
2.2 built in commands - DIR, ERA, REN, TYPE, SAVE, and USER. In addition 
you have QUIT which returns you to DOS Plus. 

  

You can use any type of disc that DOS Plus recognises, including the Acorn Z80 
format. On the subject of the Acorn Z80 many of the programs for that make 
use of the Z80 ROM. This is not supported — so don’t expect your version of Z80 
BBC Basic to run. The programs that do run are those written for any CP/M 2.2 
system and not customised to any particular hardware. 

You cannot use DOS Plus commands when running the emulator, so make sure 

you have everything set up before running Z80. This would include things such 
as getting into a subdirectory, because CHDIR is a DOS Plus command. 

Some specialist CP/M 2.2 “system” programs, such as STAT, get confused by 
the emulator. This is because they assume things about CP/M 2.2 innards — 
just try running a CP/M 2.2 version of STAT under CP/M 1.4. Anything like 
FORMAT or SYSGEN are specific to one Z80 machine, and so won't run. 

Despite the above comments most CP/M 2.2 applications do run, and can do so 

at a speed equivalent to a 1.5 MHz. 

A final word to help you install packages. The emulator supports ADMB escape 
sequences so try installing for this terminal type. Another good bet is the 
Heath/Zenith H89/19, Or if you want access to the BBC VDU sequences enter 
the following before running the emulator: 

A>DEVICE CONOUT:=RAWO 
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8.9 Problems 

Printing 
Many applications terminate lines output to the printer with a carriage return 

followed by a line feed. If your printer has the auto-linefeed option set then all 

your output will be double spaced. To correct this you should disable the 

auto-linefeed option on your printer (consult your printer documentation for 

details). In addition, if you want to use Master 128 applications such as VIEW, 

you should disable the Master 512 Co-processor and use the Control Panel 

utility on the Master 128 Welcome disc to set the printer ignore character to 0. 
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